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PREFACE

Thank you for purchasing the TV-IP322P SecurView™ Outdoor PoE
Megapixel Day/Night Internet Camera, a standalone system that can be
connected directly to an Ethernet or Fast Ethernet network.

The camera is equipped with a 2-megapixel CMOS sensor, allowing you
to capture high quality image with the resolution of up to 1280 x 1024.
Additionally, the camera features the IR (Infrared) LEDs and ICR function
(IR Cut Filter). The ICR function enables the camera to capture the clear
image under sunlight and increase the amount of light for IR LEDs in the
dark by changing the filter automatically. The camera also provides the
audio and microphone ports, allowing you to transfer sound from/to the
camera.

Compared to the conventional PC Camera, this camera features a built-in
CPU and web-based solutions that can provide a cost-effective solution
to transmit the real-time high-quality video images and sounds
synchronously for monitoring. The camera can be managed remotely, so
that you can use a web browser to access and control it from any
desktop/notebook computer over the Intranet or Internet.

Compliant with IEEE802.3af PoE (Power over Ethernet) standard, the
camera provides you with more flexibility of camera installation
according to your application. The camera can be powered by the
Ethernet, so that you can place the camera anywhere without a power
outlet supported.

The trouble-free installation procedures and web-based interface allow
you to integrate it into your network fast and easy. With comprehensive
applications supported, the Internet camera is your best solution for
remote monitor, high quality, and high performance video images.



This Advanced Installation Guide provides you with the instructions and
illustrations on how to use your camera, which includes:

Chapter 1

Chapter 2

Chapter 3

Chapter 4

Chapter 5

Chapter 6

Chapter 7

Introduction to Your Camera describes the features of the
camera. You will also know the components and functions
of the camera.

Hardware Installation helps you install the camera
according to your application environment. You can use
this camera at home, at work, at any where you want.

Accessing the Camera lets you start using your camera
without problem. The camera can be set up easily and work
within your network environment instantly.

Configuring the Camera guides you through the
configuration of the camera using the Web browser on
your PC.

Using SecurView™ Pro shows you the detail instructions on
operating SecurView™ Pro software.

How to Access the Camera Behind a Router provides the
instruction how to setup your DDNS.

Appendix provides the specification of the camera and
some useful information for using your camera.

NOTE The illustrations and configuration values in this guide are for reference
only. The actual settings depend on your practical application of the
camera.

NOTE All trademarks and logos are the property of the respective trademark
owners.
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CHAPTER 1

INTRODUCTION TO YOUR CAMERA
1.1 Checking the Package Contents

Unpack the package and check the items contained in the package
carefully. You should have the following:

e 1xTV-IP322P

e 1x Multi-Language Quick Installation Guide
e 1xCD-ROM (Utility & User’s Guide)

e 1xDesiccant **

e 2 xGPIO Connector

e 1x Spiral Cable Wrap

e 1x Camera Mounting Bracket Kit*

e 1xPower Adapter (12V DC, 1.5A)

NOTE Once any item contained is damaged or missing, contact the authorized
dealer of your locale.

*  The provided screws included: (1) screws and washers for assembling the camera
shield; (2) expansion screws for mounting the camera to the wall.

** The camera provides two packs of desiccant: one pack is pre-installed inside the

camera compartment before shipment; the extra pack is provided for replacement
while you open the back cover in the future.




1.2 Getting to Know the Camera

B The Camera and the Shield

Shield* is used to protect the
camera during inclement weather.

Lens Assembly
with IR LEDs

Connectors
Power, Audio, Mic,
GPIO, LAN

Camera Stand

* There are various positions of screw hole on the shield, allowing you to move the shield
forward/backward according to your needs. For example, it will protect the camera lens
well during rainy day by adjusting the shield forward.



B The Connectors

The camera's connectors are collected into a bundle of cable on the back
panel of the camera, allowing you to connect the external devices in a
well-ordered way while you are installing the camera onto the wall (or
ceiling).

Power
”” 1 —> Connects to the external power adapter
PIO —
/R.q E —’ Connects to the external device
—> Connects to the AC 24V AC power input
Audio out "
E‘:iﬂ:ﬂ] —» Connects to an external speaker
Mic in
w =3 Connects to an external microphone
LAN
=—Jp Connects to the network

0 Power: Connects the power adapter to supply power to the
camera.

9 GPIO: Connects the external device that features additional
controlling function, such as motion detection, event triggering,
alarm notification, and a variety of external control functions.

NOTE Before connecting the external device for GPIO function, you
have to attach the provided external GPIO connectors to the
device.

8 Audio Out: Connects an external audio device (such as the active
speaker) to deliver sound via the camera.

Mic In: Connects an external microphone to receive the on-the-
spot sound where the camera is installed.



6 LAN: Plugs the provided Ethernet cable to connect to your local
area network (LAN). The LAN port of the camera supports the
NWay protocol so that the camera can detect the network speed
automatically.



Features and Benefits

H.264/MPEG4/MIJPEG Multi-codec Supported

The camera provides you with excellent images by the
H.264/MPEG4/ MJPEG multi-codec selectable technology,
allowing you to adjust image size and quality, and bit rate
according to the networking environment.

High Resolution Surveillance

Equipped with a megapixel CMOS sensor, the high performance
camera is designed for your professional surveillance and security
applications. The image resolution is up to 1280 x 1024. In
addition, the minimum illumination of the sensor is 0 lux,
providing a truly day & night functions that allows you to capture
image even in low-light conditions.

Multiple Profiles Supported

The camera supports multiple profiles simultaneously, so that you
can separately set up different image settings (such as image
quality and frame rate) for the video types of the camera: H.264,
MPEG4, MJPEG, and 3GPP.

Flexible Audio Capability

The camera allows you to connect the external microphone to
receive on-the-spot audio via the Internet, allowing you to
monitor the on-site voice. In addition, you can connect an external
active speaker to the camera to speak through the camera
(supporting mono audio only).

Supports RTSP

The camera supports RTSP (Real Time Streaming Protocol), which
is a technology that allows you to view streaming media via the
network. You can view the real-time video with the Quick Time
player or RealPlayer. To view the real-time streaming image on
your computer, open the Web browser and enter the RTSP link:
rtsp://(IP address of the camera)/mpeg4




Remote Control Supported

By using a standard Web browser or the bundled SecurView™ Pro
software application, the administrator can easily change the
configuration of the camera via Intranet or Internet.

In addition, the camera can be upgraded remotely when a new
firmware is available. The users are also allowed to monitor the
image and take snapshots via the network.

1/0 Connectors and RS-485 Provided

The I/0 connectors (IN/OUT) of the camera provide the physical
interface to send and receive digital signals to a variety of external
alarm devices (such as motion detection, event triggering, alarm
notification, and a variety of external control functions).

The pins TX+ & TX- of the I/O connectors are used for RS-485 data
transmission, which allow you to connect a special featured
device (such as an external camera stand with rotation function)
and then configure the settings and control the device from the
GPIO Trigger window of Web Configuration.

Multiple Platforms Supported

The camera supports multiple network protocols, including TCP/IP,
SMTP e-mail, HTTP, and other Internet related protocols.
Therefore, you can use the camera in a mixed operating system
environment, such as Windows 7, Vista and XP.

Multiple Applications Supported

Through the remote access technology, you can use the cameras
to monitor various objects and places for your own purposes. For
example, babies at home, patients in the hospital, offices and
banks, and more. The camera can capture both still images and
video clips, so that you can keep the archives and restore them at
any time.

IR LEDs and IR CUT Filter Supported
The IR LEDs around the lens assembly enables the camera capture
image even in the dark environment. The night vision distance of
the IR LEDs is up to 20M. The IR CUT Filter helps the camera
increase the amount of light for IR LEDs by changing the filter
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automatically. This allows the camera to capture clear image
whenever the environment light changed.

PoE Supported

PoE (Power over Ethernet) standard enables the camera to be
powered by the Ethernet, which simplifies your surveillance
system by eliminating the need of power outlet. The PoE camera
features both stability and security, providing a cost-saving
solution to your application of Internet camera.

Please make sure that you remove the power adapter when the
camera power is supplied through PoE.
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NOTE:

System Requirement

Networking

- LAN 10 Base-T Ethernet or 100Base-TX Fast
Ethernet; Auto-MDIX.

- PoE IEEE 802.3af PoE

Accessing the Camera using Web Browser

- Platform Microsoft® Windows® 7/Vista/XP

- CPU Intel Pentium [l 800MHz or above

- RAM 512MB

- Resolution 800x600 or above

- User Interface Microsoft® Internet Explorer® 6.0 or above

Accessing the Camera using SecurView™ Pro
- Platform Microsoft® Windows® 7/Vista/XP
- Resolution 1024 x 768 or above

Hardware Requirement:
- 1~ 8 cameras Intel Core 2 Duo; 2GB RAM
- 9~ 32 cameras Intel Core 2 Quad; 4GB RAM

It is higher recommended that using a high performance
computer to monitor multiple cameras.

-12 -



CHAPTER 2

HARDWARE INSTALLATION

Swival
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2.1 Assembling the Camera Mounting Bracket

Assemble the sun visor and camera mounting bracket to the camera by
using the provided screws and washers, and then the camera can be
mounted on the wall (or ceiling) securely through the three screw holes
on the base of the holder.

B Adjust the camera position

Once you have mounted the camera to the wall (or ceiling), you need to
adjust the camera position to focus on the location where you want to
monitor. You can adjust the camera position easily by using the swivel
ball on the camera holder.

2.2 Mounting the Camera

The expansion screws in the package are used to mount the camera on
the wall (or ceiling). The following illustration provides one example of
the camera installation. You can mount the camera flexibly according to
your outdoor surveillance application.

a. Place the bracket against the wall. Mark the three holes
with a pencil.

b. Drill holes for the provided screws anchors at each marked
position.

c.  Align the mounting bracket with the screw anchors, and
then use the provided screws to secure it.

d. Secure the camera to the mounting bracket.

e. Adjust the swivel on the mounting bracket to desired
position.

B Waterproofing

The camera is designed featuring waterproof. However, you need to
protect the connectors from water soak. For example, you can tape the
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junction points of the connectors while you connect the cables or
purchase a weatherproof cable/power cord protector.

2.3 Installing the Memory Card

The camera provides a SD card slot that allows you to install the memory
card (not included in the package) to store files.

To install the memory card:

1. Remove the back cover of the camera by unscrewing the three
screws.

2. Locate the SD card slot inside the camera, and then insert the
memory card into the slot.

3. Replace the back cover and then screw the three screws.

-15-



2.4 Applications of the Camera
The camera can be applied in multiple applications, including:

® Monitor local and remote places and objects via Internet or
Intranet.

® Capture still images and video clips remotely.

® Upload images or send email messages with the still images
attached.

The following diagram explains one of the typical applications for your
camera and provides a basic example for installing the camera.

SecurView Outdoor PoE Megapixel

Day/Night Internet Camera
(TV-IP322P)

8-Port Gigabit Web Smart PoE Switch
(TPE-80WS)

SecurView PoE Dome Internet SecurView PoE Dome
Internet Camera : Internet Camera
(TV-IP252P) (TV-1P252P)

— 4-Port Broadband Router
(TW100-S4W1CA)
—— PoE

NOTE The camera’s connectors are not waterproof. Please have the
connectors protected by waterproof housing.
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CHAPTER 3

ACCESSING THE CAMERA
3.1 Using IP Setup

The camera comes with a conveniently utility, IP Setup, which is included
in the Installation CD-ROM, allowing you to search the camera on your
network easily.

1. Insert the Installation CD-ROM into your computer’s CD-ROM drive
to initiate the Auto-Run program.

@ TRENDNET

1P Setup
SecurView Pro
User's Guide
Product Registration

Exit

SecurView Outdoor PoE
Megapixel Day/Night
Internet Camera
TV-IP322P

© Copyright 2011 TRENDnet. Al Rights Reserved
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2. Click the IP Setup from the Auto-Run menu screen. Then IP Setup
Wizard will appear. Click “Next” when the Welcome to the IPSetup
Setup Wizard appears.

ﬁ IPSetup

Welcome to the IPSetup Setup Wizard

The installer will guide you thiough the steps required to install IPSetup on your computer.

WARNING: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Cancel

3. Click “Browse” to choose the desired destination location. By
default, the destination location is C:\Program
Files\TRENDnet\IPSetup. Then Click “Next”.

ﬁj IPSetup =L

Select Installation Folder

The installer will install IPSetup to the following folder.

Toinstallin this folder, click "Next". To install to a different folder, enter it below or click "Browse".

Folder:

C:\Program Files\TRENDnet\IPSetuph Browse...

|| Install IPSetup for yourself, or for anyone who uses this computer:

) Everyone

© Just me

Cancel | [ <Back | [ News> |
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4. Click “Next” to confirm the IPSetup software to be installed to the

5.

computer.
r
ﬂlPSetup —— -
Confirm Installation
The installer is ready to install IPSetup on your computer,
Click "Next" to start the installation
concal | [ <Back | [ hea»

When the Installation Complete window appears, click “Finish”.

[ %) 1PSetup

=AEE

Installation Complete

IPSetup has been successfully installed.

Click "Close" to exit.

Cancel

< Back

(@,
‘\?4...40
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After installing the IPSetup utility, the application is automatically
installed to your computer, and creates a folder in “Start
\Program\TRENDnet\IPSetup” .

Click Start > Programs > TRENDnet > IPSetup, and then click IPSetup

| . TRENDnet |7|
IPSetup
& [PSetup

4 Back

Search programs and files P |

Ia

8. The IPSetup window will appear. It will search the Camera within
the same network.

&8 IPSetup

IP Address Device Name
192.168.10.30

MAC Address
00 00d1000000

Camera Display Area

Change IP Search Exit
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Camera Display Area: It shows the connected camera(s) within the
same network. By default, the IP setting on the Camera is set up
DHCP. If you have DHCP server, the camera will automatic get the IP
address from DHCP server. If you do not have DHCP server on your
network, it will show the default IP as 192.168.10.30.

Double click the IP address; it will link to Camera’s Web
Configuration page.

Change IP: Click this button to bring up the following window. It
allows you to change the IP Address. You can select either Static IP
or click DHCP. Then, enter the Administrator ID & password. By
default ID/password is: admin. When complete, click “Change”.

Change IP Address - —_ lihj
@) Static IP
IP Address 192 . 168 . 10 . 1
Submask 285 . 288 . 28H . 0
Default gateway 192 . 18 . 10 . 100
DHCP

Administrator ID & Password

D

Password

I Change I ‘ Exit ‘

Search: Click this button to search the connected camera
within the network.

Exit: Click this button to exit the program.
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3.2 Accessing to the Camera

By default, the IP setting on the camera is set to DHCP. It is recommend
to use IPSetup to find the camera’s IP address. Once you find the IP
address of the camera, click Link to access the camera’s web page.

TIP If the camera cannot get the IP address from DHCP server, you can
access the camera by manually entering the default IP address:
192.168.10.30

When the login window appears, enter the default User name (admin)
and password (admin) and press OK to access to the main screen of the
camera’s Web Configuration.

Windows Security @

The server 192.168.1.150 at netcam requires a username and password.

Warning: This server is requesting that your username and password be
sent in an insecure manner (basic authentication without a secure
connection).

= |

D Remember my credentials

NOTE If you are the first time to access the camera, you will be asked to install
a new plug-in for the camera. Permission request depends on the
Internet security settings of your computer. Click Yes to proceed.
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The Main screen will appear as below:

@ TRE“DHET SecurView PoE Day/Night Internet Camera

TV-P322P

Location: 2011/03/22 16:06:40

)

Snapshot
Browse
Talk
Listen
Trigger Out
Multicast

The Main screen of the Web Configuration provides you with the useful
information and functions, including:

0 Live View/Setup Switch:

® Click the button to configure the camera. For

details, see Chapter 4.

® Click the button to return to the Main screen

to view the live view image.

9 Compression Buttons: Select to transmit and record the video using
H.264, MPEG4 or MJPEG compression.

9 Function Buttons: Use these buttons to control the audio, video,
and trigger functions.

® Manual Record allows you to record and save a video clip.
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® Snapshot allows you to capture and save a still image.

@® Browse allows you to assign the destination folder to store the
video clips and still images.

® Talk allows you to speak out through the camera. Please note
only one user is allowed to use this function at a time.

® Listen allows you to receive the on-site sound and voice from
the camera.

® Trigger Out allows you to trigger on/off the GPIO output
manually.

® Multicast allows you to change the camera’s transmission type
between multicast/unicast.

@ Live View Image: Displays the real-time video image of the
connected camera. The compression mode is displayed above the
Live View image.

6 Zoom Buttons: Click the zoom buttons to zoom in/out the live view
image.

@ Camera Information — Display the camera’s location and the current
date & time. The information can be modified in the Web
Configuration.

NOTE  If your computer use Microsoft® Windows® 7/Vista platform, you may
not find the recorded files that are saved by Snapshot or Manual
Record. You need to disable the protected mode of Security in the IE
Browser through the following steps:

Please follow the below Steps:
1. Open IE Browser
2. Select Tools=>Internet Options
3. Select Security
4. Uncheck the “Enable Protected Mode” then press OK

-24-



3.3 Configuring the IP Address of the Computer

If you are failed to access to the camera, please check the IP address of
your computer. When you connect the camera to your computer directly
to proceed with configuration of the camera, you need to set up the IP
addresses to be in the same segment for the two devices to
communicate.

1. Onyour computer, click Start > Control Panel to open the Control
Panel window.

2. Double-click Network Connection to open the Network Connection
window.

3. Right-click Local Area Connection and then click Properties from the
shortcut menu.

4. When the Local Area Connection Properties window appears, select
the General tab.

5. Select Internet Protocol [TCP/IP] and then click Properties to bring
up the Internet Protocol [TCP/IP] Properties window.

6. To configure a fixed IP address that is within the segment of the
camera, select the Use the following IP address option. Then, enter
an IP address into the empty field. The suggested IP address is
192.168.10.x (x is 1~254 except 30), and the suggested Subnet mask
is 255.255.255.0.

7. When you are finished, click OK.

-25-



CHAPTER 4

CONFIGURING THE CAMERA
4.1 Using the Web Configuration

You can access and manage the camera through the Web browser and
the provided software application UltraView Pro. This chapter describes
the Web Configuration, and guides you through the configuration of the
camera by using the Web browser.

To configure the camera, click on the Main screen of
Web Configuration. The Web Configuration will start from the Basic page.

The Web Configuration contains the settings that are required for the
camera in the left menu bar, including Smart Wizard, Basic, Network,
Video/Audio, Event Server, Motion detect, Event Config, Tools, RS-485,
SD Card, and Information.

@ TRENDNEeT SecurView PaE Day/Night Internet Camera

IP322P

M} Basic » System
00 Satup

(ame. TVIP322P

Smart Wizard S

Indication LED

indication LED Controt @ hormat 1 0

IR CUT & IRLED

IR CUT Controt: Auto -

[ pev—|

Tools

RS-485

SO Card

Device'Info

Copyright © 2011 TRENDnes. All ghts eaerved.
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4.2 Using Smart Wizard

The camera’s Smart Wizard lets you configure your camera easily and
quickly. The wizard will guide you through the necessary settings with
detailed instructions on each step.

To start the wizard, click Smart Wizard in the left menu bar.

Step 1. Camera Settings
By default, the camera name is set as model number. Change the name
if necessary. Enter the location and administrator password twice.

@ TRE“D"ET SecurView PoE Day/Night Internet Camera

TV-IP322P

Location: Lab  2011/03/22 16:12:29

Welcome to the Smart Wizard.
This wizard will help you quickly set up the
Network Camera to run on your network

Camera Setting

Camera Name: TV-IP322P

Camera Setting —

Camera Name: Enter a descriptive name Admin Password:
forthe camera. For example, camera 1.

Confirm Password:

Location: Enter a descriptive name for the

location used bythe camera. For example, m m

meeting room 1.

Admin Password/Confirm Password:
Enter the adminis word twice to
setand confirm the password to access the
camera's Configurati ity.
Copyright © 2011 TRENDne. All Rights Reserved.
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Step 2. IP Settings
Setup the IP setting, DHCP, Static IP or PPPoOE.

1@ pHCP

Static IP

P

Subnet Mask:
Default Gateway
Primary DN3
Secondary DNS

PPPGE

User Name:

Password

] | e

Step 3. Email Settings
Enter the mail server information. If you are using a free mails server,
select the SSL and/or STARTTLS according to the mail server requirement.

Email Setting

SMTP Server Address: Mmyserver.com

Port Number: 25

This server requires an
encrypted connection
(85L)

STARTTLS

Sender Email Address:

John.smith@myserver.com

Authentication Mode:

Mone @ SMTP

Sender User Name:

john.smith

Sender Password:

Receiver #1 Email Address:

mary.lynn@mailserver.com

Receiver #2 Email Address:

tom.bae@mailserver.com

| e
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Step 4. Confirm Settings
Click Apply to finish the setting or click Prev to change the previous
setting or click Cancel to disregard all setting.

Confirm Settings

Camera Name: TV-P322P
Location:

IP Mode: Static

IPv4 Address: 192 168.10.150
Subnet Mask: 2552552550
Default Gateway: 192.168.10.1
Primary DNS: 182.168.10.1
Secondary DNS:

SMTP Server Address:

myserver.com

SMTP Port: 25
SSL: Disable
STARTTLS: Disable

Sender Email Address:

john@myserver.com

Authentication Mode:

SMTP

Sender User Name:

john.smith

Receiver #1 Email
Address:

mary@myserver.com

Receiver #2 Email
Address:

tom@mailserver.com
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4.3 Basic Setup

The Basic menu contains three sub-menus that provide the system
settings for the camera, such as the Camera Name, Location, Date &
Time, and User management.

@ TRE“DHET SecurView PoE Day/Night InterneTtb(I:amera

-IP322P
Location:  2011/03/22 16:43:10
Basic » System
pasic

Camera Name: TV-P322P

Smart Wizard Lomnios

Indication LED

Basic
Indication LED Control: 1@ Normal ) OFF

[ustem IR CUT & IR LED
* Date & Time

— IR CUT Control: Auto w

\

Network : OFF @ 0N

\

Video/Audio

\

Event'Server

\

Motion Detect

\

Event Config

o] I»m
ol o g
Q_I.N

Device'Info

Copyright © 2011 TRENDnet. Al Hights Reserved
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4.3.1 Basic >> System

Basic » System
Basic

Camera Name: TV-IP322P

Location:

Indication LED

Indication LED Control: @ normal 2 OFF

IR CUT & IR LED

IR CUT Control: Auto w

IR LED: ZIOFF @ ON

® Basic: This item allows you to assign the camera name and
location.

- Camera Name: Enter a descriptive name for the camera, which
will help you to identify the camera when you have multiple
cameras on your network. By default, the camera name is set as
the model number.

- Location: Enter a name where the camera is located

® Indication LED: This item allows you to set the LED illumination as
desired. The available options include: Normal and OFF.

® IR CUT & IR LED: The camera features ICR function (IR CUT Filter)
and IR LED, allowing you to capture clear image when
environment light changed.

- IR CUT Control: Set the ICR function (IR CUT filter) for the
camera: Auto mode or Schedule mode.

In Auto mode, the lens filter will be switched automatically to
capture black and white image when the change of
environment light is detected by the camera’s light sensor.

- IR LED: Enable or disable the camera’s IR LED manually by
selecting ON or OFF.
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4.3.2 Basic >> Date & Time

Basic » Date & Time

Date and Time

(GMT-08:00) Pacific Time(US & Canada); Tijuana

Automatically adjust clock for daylight saving time changes
Synchronize with PC
@) Synchronize with NTP Server

NTP Server Address:

Update Interval: 6 ¥ hours
Manual
Date 2011/03/22  pyyyymmMDD)

Time: 16:47:08 (hh:mm:ss)

| Apply— = CaRcer|

® Date and Time: Enter the correct date and time for the camera.

- TimeZone: Select the proper time zone from the pull-down
menu.

- Synchronize with PC: Select this option and click Apply. The
date & time settings of the camera will be synchronized with
the connected computer.

- Synchronize with NTP Server: Select this option and enter the
NTP Server IP address, then click Apply. The date/time will be
synchronized from the NTP Server. By default, the update
interval is set to 6 hours.

- Manual: Select this option to set the date and time manually.
When done, click Apply.
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4.3.3 Basic >> User

Basic » User

User Accounts

Administrator: Password

Confirm Password: Modify

General User: User Name:

Password Add/Modify
UserList - Delete

User Name:

Password Add/Modify

UserList - Delete

Direct Video Stream I
¥|Enable Appl
Authentication: PPl

® Administrator: To prevent unauthorized access to the camera’s
Web Configuration, you are strongly recommend to change the
default administrator password. Type the administrator password
twice to set and confirm the password.

® General User

- User Name: Enter the user’s name you want to add to use the
camera.

- Password: Enter the password for the new user.

- UserlList: Display the existing users of the camera. To delete a
user, select the one you want to delete and click Delete.

When you are finished, click Add/Modify to add the new user to
the camera. To modify the user’s information, select the one you
want to modify from UserList and click Add/Modify.
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® Guest

- User Name: Enter the guest’s name you want to add to use the
camera.

- Password: Enter the password for the new guest.

® Userlist: Display the existing guests of the camera. To delete a user,
select the one you want to delete and click Delete.

NOTE The “General User” can access the camera and control the Function
buttons of the camera’s Web Configuration; the “Guest’ can only view
the live view image from the Main screen of the Web Configuration
while accessing the camera. Only the “Administrator” is allowed to
configure the camera through the Web Configuration. The maximum
12 user accounts.

® Direct Video Stream Authentication:

To steam the video directly without going through the configuration
page, you can access it via Internet.
- Enable: User needs to enter user name and password to stream
the camera.
- Disable: User can stream the camera without entering the user
name and password.

Examples of the direct link to video:
H.264 Mode
http://camera ip address:port number/h264view.htm

MPEG4 Mode
http://camera_ip _address:port number/mpgview.htm

MJPEG Mode
http://camera ip address:port number/jpgview.htm

NOTE This feature is enabled by default, and for security reason, it is
recommended to have the feature enabled at all time.
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4.4 Network Settings

The Network menu contains two sub-menus that provide the network
settings for the camera, such as the IP Setting, DDNS Setting, and IP Filter.

@ TREnDnET SecurView PoE Day/Night Internet Camera

TV-IP322P
Location:  2011/03/22 1719:15

Network » Network

@ pHoR

Smart Wizard Static IP
IP:
e Subnet Mask:

Network Default Gatewsy

Frimary DNS:
= Nstwork

« avanosa Secondary DNS:
* IPFiiter

Video/Audio User Name.

Password

Event Server

DONS Setting B Enabia

Motion Detect
Provider: www dyndns com -

_—
Event Config Host Name:

User Name:

Tools
Password

RS-485
Enable

SDCard

HTTP Port: (default: B0)

[ty e

Device Info

Copyright © 2011 TRENDnet. All Rights Reserved

4.4.1 Network >> Network

® |P Setting: This item allows you to select the IP address mode and
set up the related configuration. The default setting is DHCP mode
enabled.

- DHCP: Select this option when your network uses the DHCP
server. When the camera starts up, it will be assigned an IP
address from the DHCP server automatically.
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- Static IP: Select this option to assign the IP address for the
camera directly. You can use IPFinder to obtain the related
setting values.

IP Enter the IP address of the camera. The default
setting is 192.168.10.30.

Subnet Mask Enter the Subnet Mask of the camera. The
default setting is 255.255.255.0.

Default Enter the Default Gateway of the camera. The

Gateway default setting is 192.168.10.1.

Primary/ DNS (Domain Name System) translates domain

Secondary DNS names into IP addresses. Enter the Primary DNS
and Secondary DNS that are provided by ISP.

- PPPOE: Select this option when you use a direct connection via
the ADSL modem. You should have a PPPoE account from your
Internet service provider. Enter the User Name and Password.
The camera will get an IP address from the ISP as starting up.

NOTE Once the camera get an IP address from the ISP as starting up, it
automatically sends a notification email to you. Therefore, when you
select PPPoE as your connecting type, you have to set up the email or
DDNS configuration in advance.

® DDNS Setting: With the Dynamic DNS feature, you can assign a
fixed host and domain name to a dynamic Internet IP address. To
set up the DDNS:

1. Select the Enable option to enable this feature.
2. Select the Provider from the pull-down list.

3. Enter the required information in the Host Name, User
Name, and Password boxes.

NOTE You have to sign up for DDNS service with the service provider before
configuring this feature. Please refer to Chapter 6 for detail
information.

® UPnP: The camera supports UPnP (Universal Plug and Play), which
is a set of computer network protocols that enable the device-to-
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device interoperability. In addition, it supports port auto mapping
function so that you can access the camera if it is behind an NAT
router or firewall. Select the Enable option to enable this feature.

® Ports Number
- HTTP Port: The default HTTP port is 80.

NOTE If the camera is behind an NAT router of firewall, the suggested port
to be used is from 1024 to 65535.

4.4.2 Network >> Network >> Advanced

Network » Advanced

HTTPS

[default: 443)

Enable

Friendly Hame:

RTSP Streaming

Authentication: Disable ¥

RTSP Port: 554 (default: 554)

Multicast settings

Group IP: . 258 0 0
H.264 Port 1234 (default: 1234)
MPEGA4 Port 1236 (default: 1238)
Audio Port 1238 (defoult: 1238)
TIL: 255 {1~255)

Live Video DSCP: 0 {0~83)
Live Audio DSCP: o 10~83) I
® HTTPS

- Enable: Select this option to enable HTTPS, which is a secure
protocol to provide authenticated and encrypted
communication within your network.

- HTTPS Port: Assign a HTTPS port in the text box. The default
HTTPS port is 443.
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® Bonjour: The devices with Bonjour will automatically broadcast
their own services and listen for services being offered for the use
of others. If your browser with Bonjour, you can find the camera
on your local network without knowing its IP address.

The Apple Safari is already with Bonjour. You can download the
complete Bonjour for Internet Explorer browser from Apple's web
site by visiting http://www.apple.com/bonjour/.

® RTSP

- RTSP Streaming: Selection the Authentication as Disable or
Enable to configure the transmission of streaming data within
the network. The default RTSP Port (Real Time Streaming
Protocol) is 554.

- Multicast settings: Configure the following settings so that you
can deliver information from your camera to a set of receivers.

Group IP Assign a category of IP addresses to receive the
information from the camera.

H.264 Port Assign a multicast port for H.264 in the text box. The
default port is 1234.

MPEG4 Port Assign a multicast port for MPEG4 in the text box. The
default port is 1236.

Audio Port Assign a multicast port for audio in the text box. The
default port is 1238.

TTL Set the TTL value from 1 to 255, which is used to
modify the time to live field in the IP header.

® QoS

- Live Video DSCP: Assign the DSCP (DiffServ Code Point) of the
stream video from the camera.

- Live Audio DSCP: Assign the DSCP (DiffServ Code Point) of the
stream audio from the camera.

-38 -


http://www.apple.com/bonjour/

4.4.3 Network >> IP Filter

Network » IP Filter

1P Filter

IPvd Address Range

IPvE Address:

Deny

IPv4 Address Range

IPvE Address:

The IP Filter setting allows the administrator of the camera to limit the
users within a certain range of IP addresses to access the camera.

To disable this feature, select the Disable option; otherwise, select the
Accept option to assign the range of IP addresses that are allowed to
access the camera, or select the Deny option to assign the range of IP
addresses that are blocked to access the camera.

® Disable: Select this option to disable the IP Filter function of the
camera.

® Accept

- IPv4: Assign a range of IP addresses that are allowed to access
the camera by entering the Start IP address and End IP address
options. When you are finished, click Add to save the range
setting. You can repeat the action to assign multiple ranges for
the camera.

For example, when you enter 192.168.10.50 in Start IP Address
and 192.168.10.80 in End IP Address, the user whose IP address
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located within 192.168.10.50 ~ 192.168.10.80 will not be
allowed to access the camera.

- IPv6: Enter the IP Address that is allowed to access the camera.

® Deny

- IPv4: Assign a range of IP addresses that are blocked to access
the camera by entering the Start IP address and End IP address
options. When you are finished, click Add to save the range
setting. You can repeat the action to assign multiple ranges for
the camera.

For example, when you enter 192.168.10.50 in Start IP Address
and 192.168.10.80 in End IP Address, the user whose IP address
located within 192.168.10.50 ~ 192.168.10.80 will not be
allowed to access the camera.

- IPv6: Enter the IP Address that is not allowed to access the
camera.
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4.5 Setting up Video & Audio

The Video & Audio menu contains four sub-menus that provide the video
and audio settings for the camera.

@ TRENDNET SecurView PoE Day/ Night Internet Camera

-IP322P
Location: 201110322 16:06:09

v Video & Audio » Camera
Set 3 ;

—
4 “ 7
Smart Wizard e iﬂ

Basic

Network

—_—
Video/Audio
* Camera
*Video
e Image Setting
* Overlay/Mask

Black Level: (0~5)
Event Server

Brightness: (0~100)

Motion Detect Saturation: (0~100)

Event Config Sharpness: (0~100) Default |

Mirror: | Vertical || Horizontal
Tools

Light Frequency: 50Hz @ 60Hz

RS-485 AE Control: Fast ) Normal @ Slow

-~ ) X =
SD Card Night Mode: Color i) Mono

Device'Info

Copyright © 2011 TRENDnet. All Rights Reserved.
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4.5.1 Video & Audio >> Camera

Image Setting

Black Level 0 {0~5)

Brightness: 27 [0~100}

Saturation 50 {0~100}

Sharpness: 30 {0~100} Default

Mirror:

[ vertical [ Horizontal

Light Frequency: "I 50Hz @) 60Hz
AE Control: @ Fast ) Normal Z) Slow
Night Mode: @ Color & Mono

® Image Setting

- Black Level: Adjust the brightness level from 0 ~ 5.

- Brightness: Adjust the brightness level from 0 ~ 100.

- Saturation: Adjust the colors level from 0 ~ 100.

- Sharpness: Adjust the sharpness level from 0 ~ 100.

TIP  Click Default to restore the default settings of the three options above.

- Mirror: Select Vertical to mirror the image vertically, or select
Horizontal to mirror the image horizontally.

- Light Frequency: Select the proper frequency according to the
camera’s location to reduce the noise: 50Hz or 60Hz.

- AE Control: Select AE (Auto Exposure) speed as Fast, Normal or

Slow.
Mode Frequency AE Control (Day Time) AE Control (Night Time)
min. shutter speed min. shutter speed
Fast Normal Slow Fast Normal Slow

60Hz 1/120s 1/60s 1/30s 1/120s 1/60s 1/30s
VGA 50Hz 1/100s 1/50s 1/25s 1/100s 1/50s 1/25s

60Hz 1/120s 1/60s 1/15s 1/120s 1/60s 1/15s
SXGA 50Hz 1/100s 1/50s 1/12.5s 1/100s 1/50s 1/12.5s

- Night Mode: Select to capture Color or Mono image when in
dark environment.
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4.5.2 Video & Audio >> Video

Video & Audio » Video

Video Resolution: SKGA  w

Highest w

15w o

VGA -

Highest w

15w o

Video Resolution: SKGA  w

Video Quality: High =

Frame Rate: 15 ¥ fos

None IE Browser Viewer: | Java Applet =

@ Disable
12 3GPP Without Audio
71 3GPP With Audic

® H.264

- Video Resolution: Select the desired video resolution from the
four formats: SXGA, VGA, QVGA and QQVGA. The higher
setting (VGA) obtains better video quality while it uses more
resource within your network.

- Video Quality: Select the desired image quality from five levels:
Lowest, Low, Medium, High, and Highest.
- Frame Rate: Select Auto or a proper setting depending on your
network status.
® MPEG4

- Video Resolution: Select the desired video resolution from the
three formats: VGA, QVGA and QQVGA. The higher setting
(VGA) obtains better video quality while it uses more resource
within your network.

- Video Quality: Select the desired image quality from five levels:
Lowest, Low, Medium, High, and Highest.
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- Frame Rate: Select Auto or a proper setting depending on your
network status.

® MIJPEG

- Video Resolution: Select the desired video resolution from the
four formats: SXGA, VGA, QVGA and QQVGA. The higher
setting (VGA) obtains better video quality while it uses more
resource within your network.

- Video Quality: Select the desired image quality from five levels:
Lowest, Low, Medium, High, and Highest.

- Frame Rate: Select Auto or a proper setting depending on your
network status.

NOTE The camera supports H.264, MPEG4 and MJPEG compression.
Please note that that MJPEG mode captures the images in JPEG
format, which requires higher bandwidth to view smooth video.
You can control the bandwidth of each connection well through
the setting options above. For the bandwidth information, refer
to the Appendix, Bandwidth Reference Guide.

® 3GPP: The camera supports 3GPP specification. Select the Disable
option to disable this feature. Otherwise, select 3GPP Without
Audio or 3GPP With Audio to transfer the video clips without or
with audio.

If you use a mobile phone that supports 3GPP, you can also view
the real-time streaming image captured by the camera on your
phone (with the default player on the phone) by entering the
RTSP link: rtsp://(IP address of the camera)/3gp.

NOTE Your mobile phone and the service provider must support 3GPP
function. Please contact your service provider when you are
failed to use this service.
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4.5.3 Video & Audio >> Audio

Video & Audio » Audio

Camera Microphone In

Camera Speaker Out

® Camera Microphone In: Select the Enable option to enable the
camera’s audio function, so that you can receive the on-site sound
and voice from the camera.

® Camera Speaker Out: Select the Enable option to enable the
camera’s external speaker function, so that the connected
speaker can play the sound and voice through the camera.

You can set the speaker’s volume by entering the proper value in
the Volume option. The default setting is 90.
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454

@ TRENDNET Secur\View PoE Day/Night Internet Camra

Video & Audio >> Overlay / Mask

22P

Location: 201110322 16:08:36

Overlay/Mask

Smart Wizard

Basic

Network

* Camecs

*Video
« Autio

e —1
Video/ Audio |
Ih

* Qvardaiban
* st Overtay

Event Server

Motion Detect:

Event Config

Tools

RS-485

SD'Card

Device Info

Copymght © 2011 TRENDRct. Al Fights Reserved

This sub-menu is used to set the image overlay and mask feature of the
camera.

Image Overlay: This item allows you to set the image overlay.

In the Image File option, click Browse to select the image file from
your computer, and then click Upload. You can click Preview to
check the image size and adjust the image position before clicking
Upload. The preview image area is displayed with red dotted line.
If you want to remove the preview image before uploading, click
Delete.

Since you click Upload, the preview image area is displayed with
white dotted line. Click Enable and set the transparency setting by
whether selecting the Transparent option or not.

When done, click Apply. You can see the image overlay on the live
view image when you click Live View.
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NOTE  The width and height of the input overlay graphic should be
multiple of 4 at a maximum size of 43690 pixels, and in JPG or
BMP (24-bit RGB) format.

Privacy Mask: This item allows you to configure up to two mask
areas.

Select the area 1 or 2 from the Window pull-down list, and then
click Enable. You can change the size and position of the area by
holding and dragging the mouse.

You can also change the color of the mask area by clicking the
Color box and then selecting the color you want.

When done, click Apply. You can see the mask area(s) on the live
view image when you click Live View.

4.5.6 Video & Audio >> Overlay / Mask >> Text Overlay

This page is used to set the text overlay feature of the camera, including
the following three options: date & time, heading text, and background
transparency setting.

Include Date & Time: Select this option to display the date & time
information on the live view image.

Include Text: Select this option and enter your heading text in the
box to display the text information on the live view image.

Enable Opaque: Select this option to display the overlay text with
a background color.
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For example, when you select the Include Date & Time and Include Text
options and click Apply, you can see the related information displayed

on the live view image when you click the button.

@ TRENDNET

aw
= e AR F
§2011/03/22 18:33:03

T
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4.6 Event Server Configuration

The Event Server menu contains four sub-menus that allow you to
upload images to FTP, send emails that include still images, and store the
images to a NAS system.

When you complete the required settings for HTTP, FTP, Email, or
Network Storage, click Test to test the related configuration is correct or
not. Once the camera connects to the server successfully, click Apply.

@ TRE”DnET SecurView PoE Day/Night Internet Camera

TVIP322P

Location 2041701401 00:18:54

Event Server Setting » HTTP

HTTP Motify For Motion Trigger

Smart Wizard

Basic

Network 3 iogilevent. ogiTstatus=#sAtime=#t
Video/Audio

Event Server

- Hedwork Horzoe
- Instai Mes32ge

o logilevent.ogi Pstatus=#sEtime=#t
Motion Detect = =

Event Config

Tools

RS-485

SD'Card

Device Info 3 fogilevent.ogi Pstatus=#satime=4t

Copyright © 2011 TRENDnet. All Rights Reserved
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4.6.1 Event Server Setting >> HTTP

Event Server Setting » HTTP
HTTP Notify For Motion Trigger

Host:

Port: 80

User Name:

Password:

Query: lcgifevent cgi?status=#s&time=#t
Host:

Port: 80

User Name:

Password:

Query: legifevent cgi?status=#s&time=#t
Host:

Port: 80

User Name:

Password:

Query: fegifevent cgi?status=#s&time=#t
| ]|
B HTTP Notify For Motion Trigger

Send the query parameter via an HTTP notification when an event is
triggered.

- Host: Enter the IP of the HTTP server

- Port: Enter the Port number of the HTTP server

- User Name: Enter the username of the HTTP server

- Password: Enter the password of the HTTP server

- Query: Enter the query parameter for the request if necessary
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Example:

Host: 192.168.10.1

Port: 80

Query: xxx.cgi?namel=valuel&name2=value2
Ex: cgi/event.cgi?status=#s&time=#t&model=modelname

Result:

http://192.168.10.1:80/cgi/event.cgi?status=#s&time=#t&model=

modelname

4.6.2 Event Server Setting >> FTP

FTP

Host Address:

Event Server Setting » FTP

65.64.63.62

Port Number:

21

User Name:

fipserver

Password:

Directory Path:

test

Passive Mode:

¥| Enable

FTP Upload With:

@) One Snapshot

Pre-event 3 ¥ |sec(s) Postevent |2 ¥ sec(s)

® FTP
- Host Address: Enter the IP address of the target FTP server.

- Port Number: Enter the port number used for the FTP server.

- User Name: Enter the user name to login into the FTP server.

- Password: Enter the password to login into the FTP server.

- Directory Path: Enter the destination folder for uploading the
images. For example, test.

- Passive Mode: Select the Enable option to enable passive mode.
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- FTP Upload with: Select upload to FTP with one snapshot image
or a series image in pre-event/post-event time when event
triggered.

NOTE Due to the network environment, the camera may not upload

number of images that you set.

4.6.3 Event Server Setting >> Email

Event Server Setting » Email

Email

SMTP Server Address:

mymail.com

Sender Email Address:

Jjohn@mymail.com

SMTP Port:

25

This server requires an
encrypted connection
(SSL):

STARTTLS:

Authentication Mode:

None @ SMTP

Sender User Name:

john_smith

Sender Password:

Receiver #1 Email
Address:

mary@mymail.com

Receiver #2 Email
Address:

george@gmail.com

@ One Snapshot
Send Email With: -
Pre-event | 3 ¥ |sec(s) Postevent |2 ¥ sec(s)

Wan IP Change Notify:

® Email

- SMTP Server Address: Enter the mail server address. For
example, mymail.com. If you are using a free mail service (e.g.
Google Gmail®, Yahoo®, Hotmail®), please enter the SMTP
server address from the service provider.

- Sender Email Address: Enter the email address of the user who
will send the email. For example, John@mymail.com.
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- SMTP Port: Assign the SMTP port in the text box. The default
SMTP port is 25. If the mail server requires an encrypted
connection, you should check the SSL option.

- SSL / STARTTLS: Most free email services require an encrypted
connection. If you are using a free email service, please check
the mail server requirement and select the options that apply to
the server.

- Authentication Mode: Select None or SMTP according to the
mail server configuration.

- Sender User Name: Enter the user name to login the mail server.
- Sender Password: Enter the password to login the mail server.

- Receiver #1 Email Address: Enter the first email address of the
user who will receive the email.

- Receiver #2 Email Address: Enter the second email address of
the user who will receive the email.

- Send Email With: Select the attachment type that is to be
added to the email.

NOTE Depending on the network environment, your network may not be
able to send all the screen shots that was set to your email account.

- Wan IP Change Notify

Select the option to enable the system to notify you when the
WAN IP address changed.
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4.6.4 Event Server Setting >> Network Storage

Event Server Setting » Network Storage
Network Storage

Samba Server Address:

192 16810 10]

Share:

IP322P

Path:

test

User Name:

admin

Anonymous

Password:

Split By:

@ File Size 100 (MB)

Recording Time 30 (Minutes)

When Storage Full:

Stop Recording
@ Recycle - Delete Oldest Folder

Encode Format:

MPEG4
@ H264

File Format:

MP4
@AVl

e e e ]

Network Storage

Samba Server Address: Enter the IP address of the Network
Storage server.

Share: Assign the folder on the Network Storage server to share
the files to users.

Path: Assign the path for uploading the files on the Network
Storage server. For example, Test.

User Name: Enter the user name to login into the Network
Storage server.

Password: Enter the password to login into the Network
Storage server.

Split By: When the file is too large to upload smoothly, use this
option to split it by selecting File Size or Recording Time.

When Storage Full: Select Stop Recording or Recycle — Delete
Oldest Folder when the storage space on the Network Storage
server is full.
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- Encode Format: Select MPEG4 or H.264 as the encode format
while recording.

- File Format: Select MP4 or AVI as the file format while
recording.

NOTE The recorded video files in Network Storage are enclosed by
AVI format without audio.

4.6.5 Event Server Setting >> Instant Message

Event Server Setting » Instant Message

Instant Message

test@gmail.com

Manually Specify Server

¥| Enable
Host/Port:

Jabber Server Address: | talk google.com

Jabber Port: 5222

Encrypt Connection: ¥| Enable

Encrypt Authentication: ¥| Enable

Receiver: trendnettest1@gmail.com

Message: TV-IP322P Event Detect

| Test T AGply g Cancel

The camera supports the Jabber IM service, so that you can send an
instant message once you have a Jabber account. For more information
of Jabber, please visit the Jabber Website at:
http://jabber.org/Main_Page. The information show above is using
google talk.
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Instant Message

Jabber ID: Enter your user ID to login into the Jabber IM service.

Jabber Password: Enter the password to login into the Jabber
IM service.

Manually Specify Server Host/Port: Select the Enable option to
manually configure the Jabber server settings.

Jabber Server Address: Enter the Jabber server address
manually.

Jabber Port: Assign the Jabber port manually in the text box.

Encrypt Connection: Select the Enable option to secure the
connection.

Encrypt Authentication: Select the Enable option to secure the
connection.

Receiver: Enter the receiver’s information.

Message: Enter the message that is to be sent.
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4.7 Motion Detect

The Motion Detect menu contains the command and option that allow
you to enable and set up the motion detection feature of the camera.
The camera provides three detecting areas.

@ TRENDNET SecurView PoE Day/Night Internet Camera

TV-P322P

Location: 201100322 16:32:46

Motion Detection » Detection Configuration

"Smart Wizard
Basic

Network

ides)/ Rudie
Event Server
"Wiotion Detect
TEvent Contig
Tools

RS-485

SD Card

Device Info

Copyright © 2017 TRENDnes. Al Righta Reserved

To enable the detecting area, select Window 1/2/3 from the pull-down
list, and then select Enable. When the detecting area is enabled, you can
use the mouse to move the detecting area and change the area coverage.

® Name: Assign a name to the detecting area.

® Threshold: Move the slide bar to adjust the level for detecting
motion to record video.

NOTE Sliding the Threshold bar to the right will decrease the sensitivity of
motion detection; sliding the Threshold bar to the left will increase
the sensitivity of motion detection.
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4.8 Event Configuration

The Event Config menu contains five sub-menus that provide the
commands to configure event profiles.

@ TRENDNET

SecurView PoE Day/Night Internet Camera
TV-IP322P

Location:  2011/0: 1:47:02

Event Configuration » General Setting

L0 Setup General

Snapshot/Recording Filename Prefix

Smart Wizard
Recording Interval:
Basic

20 seqs)

Metwork Storage Recording Time Per Event

GPIO Trigger Out Interval:
Network

20 seo)
GPIO Trigger Out Per Event

g o | |

Event Server
Motion Detect

Event Config

- Ganeral
- scnsaus Proms
- Motion Trigger
- Schsdusa Trigger
- GRID Trigger

Tools
RS-485
SDCard

Device'Info

Copyright € 2011 TRENDnet. All Rights Reserved

-58 -



4.8.1 Event Configuration >> General Setting

Event Configuration » General Setting

General

Filename Prefix:

Snapshot/Recording Filename Prefix

Recording Interval:

20 zeofs)

Network Storage Recording Time Per Event

GPIO Trigger Cut Interval:

20 seos)
GFIC Trigger Out Per Event

® General

- Snapshot/Recording Subfolder: You can assign a descriptive
name for the subfolder to save the captured image/video files.
Otherwise, leave this option blank to use the default setting.

- Storage Recording Time Per Event: Limit the recording time
while you are using the Network Storage solution.

- GPIO Trigger Out Retention Time Per Event: Limit the retention
time of the GPIO Trigger Out function.

4.8.2 Event Configuration >> Arrange Schedule Profile

Event Configuration » Arrange Schedule Profile

Schedule Profile

® Schedule Profile: This sub-menu displays the scheduled profile(s).
To customize the profile, click Add and then enter a descriptive
name for the profile in the prompt dialog window. After entering
the profile name, click OK and the profile is added to the Schedule
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Profiles list. To delete the profile, select the profile in the list and
click Delete.

Event Configuration » Arrange Schedule Profile

Schedule Profile

Profile Name: test

Weekdays: 9 Sun':' I'\-Ian':' TuE':"ll'.l’E:I':'Thu':'

Time List:

I Add ] [ Copy this to all weekdays ]

I Delete “ Delete this from all weekdays ]

- Profile Name: Display the profile name that you select in the
Schedule Profiles list.

- Weekdays: Select the weekday(s) that you want to separately
assign in the schedule profile. The weekday that has been
assigned will be displayed with green color.

- Time List: Display the time period that you have assigned within
the selected weekday. To assign the same time period to every
weekday, click Copy this to all weekdays; click Delete this from
all weekdays to remove the selected time period from every
weekday. Click Delete to remove the selected time period.

- Start/End Time: Enter the start and end time and then click Add
to assign a time period within in the selected weekday.
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4.8.3 Event Configuration >> Motion Detect Trigger

Event Configuration » Motion Detect Trigger

Motion Detect Trigger
(*Please set the corresponding server setting first)

Enable td

Schedule Profile: always ¥

Trigger Out

Record to SD Card

Record to Network Storage
Send Email

FTP Upload

Instant Message

HTTF Notify

® Motion Detect Trigger: Select the Enable option to enable the
trigger function of the camera, so that you can send captured
images within the detecting area to the FTP server, email receiver,
or the Network Storage server. You have to configure
corresponding settings, such as FTP server and email server, to
enable this feature. Please note that you have to configure the
related settings before enabling these features.

- Schedule Profile: Select a schedule profile from the pull-down
list.

- Action: Set the Trigger Out function or select the destination
that the captured images will be sent to:, or Record to SD Card,
Record to Network Storage, Send Email, FTP Upload, or Instant
Message.
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4.8.4 Event Configuration >> Schedule Trigger

Event Configuration » Schedule Trigger

Email Schedule
Enable Kl

Schedule Profile: always =

20 secs)

O

always

30 secs)

O

Schedule Profile: always =

Interval: 30 secs)

You can separately configure the schedule for trigger function of the
camera by Email, FTP, or Network Storage. Select the Enable option
on each item, and then select a Schedule Profile from the pull-down
list and set the Interval time.

NOTE If the setting value of the Network Storage Recording Time Per
Event option in General Setting is longer than the Interval time in
Network Storage Schedule, the recorded file will be a continuous
video clip.

For example, if you set the Network Storage Recording Time Per
Event as 10 seconds and the Interval as 5 seconds, recorded file

becomes a non-stop video clip because the camera will record a
10-second video clip every 5 seconds.
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4.8.5 Event Configuration >> GPIO Trigger

Event Configuration » GPIO Trigger

GPIO Trigger
Enable Trigger In 1

Schedule Profile: always

Trigger Out
Record to SD Card

Record to Network Storage
Send Email

FTP Upload

Instant Message

HT TP Motify

Enable Trigger In 2

Schedule Profile: always «

Trigger Out

Record to SO Card

Record to Network Storage
Send Email

FTP Upload

Instant Message

HTTF Notify

® GPIO Trigger: Select the Enable Trigger In 1/2 option to enable
the GPIO trigger function of the camera, so that you can set
Trigger Out function or send captured images within the detecting
area to the SD card, FTP server, email receiver, Network Storage
server, or send an instant message. Event server has to be
configured prior to using the functions.

- Schedule Profile: Select a schedule profile from the pull-down
list.

- Action: Set the Trigger Out function or select the destination
that the captured images will be sent to: Record to SD Card,
Record to Network Storage, Send Email, FTP Upload, or Instant
Message.
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4.9 Tools

The Tools menu provides the commands that allow you to restart or
reset the camera. You can also backup and restore your configuration,
and upgrade the firmware for the camera.

@ TRE“D“ET SecurView PoE Day/Night Internet Camera

TV-IP322P

Location:  2011/03/22 16:33:44

System Tools » Tools

Live View
£ Setup Factory Reset
Factory reset will restore the device's factory default settings.

Smart Wizard

\

i System Reboot

\

Network Reboot the device

\

Video/Audio

\

Event'Server Configuration

\

= Backup the device configurations. Click the button bellow and save the
Motion Detect P .
device configurations to your local harddrive.

Event Config Get the backup file

— Restore your device's configuration from a backup file

Browse. Restore

\

|

\

RS-485

\

SDCard Update Firmware

Current Firmware Version: 1.0.0 build:11

\

Device'Info
Selectihe firmware:

Copyright © 2011 TRENDnet. All Rights Reserved
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Factory Reset: Click Reset to restore all factory default settings for
the camera. You can also do the physical reset by press the reset
button on the camera. Remove the front cover of the camera and
press the reset button as indicates below.

System Reboot: Click Reboot to restart the camera just like
turning the device off and on. The camera configuration will be
retained after rebooting.

Configuration: You can save your camera configuration as a
backup file on your computer. Whenever you want to resume the
original settings, you can restore them by retrieving the backup
file.

- Backup: Click Get the backup file to save the current
configuration of the camera.

- Restore: Click Browse to locate the backup file and then click
Restore.

Update Firmware: You can upgrade the firmware for your camera

once you obtained a latest version of firmware.

- Current Firmware Version: This item displays the current
firmware version.

- Select the firmware: Click Browse to locate the backup file and
then click Update.

NOTE Make sure to keep the camera connected to the power source

during the process of upgrading firmware. Otherwise, the

camera might be damaged because of failure of upgrading
firmware.
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4.10 RS-485

The RS-485 menu provides the control settings for external device
through the 1/0 port.

@ TREnDnET SecurView PoE Day/Night Inl:erngrt. Camera

V-IP322P

Location:  2011/03/22 16: 7

RS-485 » RS-485 Setting

RS-485

Enable

Smart Wizard Baud Rate:

9! Popular Protocol Setting

i) Protocol Pelco-D -

Network a1 1 (Pelco-D:0~254 Pelco-Pi1~32)

\_! Custom Protocol Setting

Video,/Audio

Home :

Event Server
Up:

Motion Detect Down :

Event Config (L=

Tools

RS-485

‘Command

~RS-485
* Patrol

SD'Card

External Command 1 :

External Command 2

External Command 3 :

Device'Info
External Command 4 :

External Command 5 :

Copyright © 2011 TRENDnet. All Rights Reserved.
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4.10.1 RS-485 >> RS-485 Setting

RS-485 » RS-485 Setting
RS-485

Enable
Baud Rate: 2400 w
9! Popular Protocol Setting
Protocol Pelco-D v
Camera ID : 1 {Feloo-D:0~254 Peloo-P:1~32)
Custom Protocol Setting
Home : [Test]
Down - Test
Left: Test]
Right - \E‘
Stop
Mame ‘Command
External Command 1 © Test|
External Command 2 © [Test]
External Command 3 - [Test]
External Command 4 : [Test]
External Command 5 : IEI
T

Select the Enable option and complete the required configuration to use
the RS-485 function of the device.

® Popular Protocol Setting: Select a Protocol (Pelco-D or Pelco-P)
and then select a Camera ID.

® Custom Protocol Setting: Select this option to configure the
commands protocol manually. You can click Test to test each
command that you have assigned. In the Name and Command
string boxes, you can customize more buttons for your needs.
Please note that the setting values in the Command string boxes
should be from the connected external device (please refer to the
manual of the connected device).
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4.10.2 RS-485 >> Patrol

RS$-485 » Patrol Setting

Preset Position

Add to be Patrol Position
Patrol Position

Patrol Path Stay Time

R ]

The Patrol function provides the patrol control settings for the
connected camera.
® Preset Position
To set the preset position for the connected camera:

1. Use the Navigation buttons to move the camera lens to the
desired position.

2. Select a Position number (Home, 2~32) from the Preset
Position pull-down list.

Enter the descriptive name for the location in the text box.

Click Apply.

- Pan Speed: Adjust the moving speed (1 ~ 10) while
panning the lens.

- Tilt Speed: Adjust the moving speed (1 ~ 10) while tilting
the lens.
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- Zoom Speed: Adjust the speed (1 ~ 10) while zooming
the lens.

- Focus Speed: Adjust the speed (1 ~ 10) while focusing the
lens.

- Zoom Inf/Zoom Out: Click to zoom in/out the live view
image.

- Focus Far/Focus Near: Click to adjust the focus by
far/near.

® Patrol Position

This field allows you to set the positions for camera’s patrolling:

1.

Select a preset position from the Preset Position pull-down
list, and then click Add to be Patrol Position. The preset
position will be added to the Patrol Path list.

From the Patrol Path list, you can change the patrolling order
by selecting a position and clicking Up or Down. You can also
delete a position by clicking Remove.

You can change the stay time for each position when the
camera is patrolling. Select a position in the Patrol Path list
and then enter a time setting in the text box below the Stay
Time list. Click Update to save the setting. The Stay Time list
displays the current setting for each position.

When done, click Save.

-69 -



4.11 Setting up the SD Card

The SD Card menu allows you to set the SD card function installed in the
camera.

@ TRE“DnET SecurView PoE Day/Night Interngrt. Camera

V-IP322P

Location:  2011/03/22 16:36:57

SD Card » SD Card Setting
SD Card Dismount

SmartWizard SD Card Information

Total space: 7976 Mb

\

Basic s 7976 Mb

\

Network SD Card Setting

When Storage Full: Stop Recording

\

Video/Audio
@ Recycle - Delete Oldest Folder

\

Event Server Encode Format: MPEG4

@ H.264

\

Motion Detect
File Format: @ npPa

\

Event Config AV

\

4
o
o
o

w) s
o &
() o
3 o
2 [3)]

+ 5D Card
* File Manager

\

Device'Info

Copyright © 2011 TRENDnet. All Rights Reserved.
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4.11.1 SD Card >> SD Card Setting

® SD Card Dismount: Click Dismount to safely remove the SD card
that is installed in the camera.

Note: You must disable the event trigger in order to dismount the
SD Card.

® SD Card Information: Displays the information of the installed SD
card, including the Total space and Free space.
® SD Card Setting

- When Storage Full: Select Stop Recording or Recycle — Delete
Oldest Folder when the storage space on the SD card is full.

- Encode Format: Select MPEG4 or H.264 as the encode format
while recording.

- File Format: Select MP4 or AVI as the file format while
recording.

4.11.2 SD Card >> File Manager

The File Manager menu allows you to download files from the SD card.
Select the desire file and click the Download button to download the file.

SD Card » File Manager

File Manager

= 20110322 File Name: [/20110322/16/163836.mp4]
= 16

B 163626.mp4
H 1837

H 163623.mpa
B 153028.mp4
B 154044 mpa
B 184251.mpa
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4.12

Information

The Information menu displays the current configuration and events log

of the camera.

@ TRENDnET

ﬂ
s
i
g
[-%

\

Basic

\

Network

\

Video,/Audio

\

Event Server

\

Motion Detect

\

Event Config

\

Tools

\

RS-485

\

SD'Card

\

Device Info

+ Device Info
System Log

SecurView PoE Day/Night Internet Camera
TViP322P

Location: 2011/03/22 16:36:44

System Information » Device Information

Basic

Camera Name:

Tv-IP322P

Location:

Firmware Version:
Video & Audio

H.264 Resolution:

1.0.0 build: 11

MPEG4 Resolution:

MJPEG Resolution:

SXGA

3GPP Enable:

Disable

Wicrophone In:

Enable

Speaker Qut:
Network

IP Mode:

Enable

Static

IPv4 Address:

192.168.10150

IPv4 Subnet Mask:

2552552550

1Pv4 Gateway:

192168101

Primary DNS Address:

192.168.10.149

Secondary DNS address:

IPv Address:

1e80:2f76/fe00:309

IPv6 Gateway:

NIA

MAC Address:

O00:FFFFFRFFFF

UPnP Enable:

Enable

HTTP Port:

80

554

67.200.100-58

Gopyright © 2011 TRENDnet. All Rights Reserved.
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4.12.1 System Information >> Device Information

Display the Basic, Video & Audio, and Network settings of the camera.

System Information » Device Information

I

Camera Name: Tv-P322P
Location:

Firmware Version: 1.0.0 build: 11
H.264 Resolution: SXGA

MPEG4 Resolution: VGA

MJPEG Resolution: SXGA

3GPP Enable: Disable
Microphone In: Enable
Speaker Out: Enable

1P Mode: Static

1Pv4 Address: 192.168.10 150
IPvd Subnet Mask: 255.255.255.0
1Pv4 Gateway: 192.168.10.1
Primary DNS Address: | 192.168.10.149
Secondary DNS address:

1Pv6 Address: fe80::2f. 7611200309
IPv6 Gateway: A

MAC Address: 00:FF:FFFF.FFFF
UPRP Enable: Enable

HTTP Port: 80

RTSP Port: 554

Wan IP: 67.200.100.58

4.12.2 System Information >> Logs

The Logs table displays the events log recorded by the system.

System Information » Logs
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CHAPTER 5

SECURVIEW™ PRO SOFTWARE

This chapter describes detailed instructions on using SecurView™ Pro, a
customized software application with a user-friendly interface that
allows you to access your cameras. The Software can monitor and record
up to 36 cameras. It also let you change some basic settings of the
camera, such as schedule profiles and motion detecting areas. The
SecurView™ Pro also supports audio or Pan/Tilt function.

It is recommended to use a high performance computer if you want to
connect multiple cameras simultaneously.

® Platform: Microsoft® Windows® 7/Vista/XP
Hard Disk: 80GB or above

Resolution: 1024x768 or above

Hardware Requirement

1~ 8 cameras: Intel Core 2 Duo; 2GB RAM
9 ~ 32 cameras: Intel Core 2 Quad; 4GB RAM

* For Windows Vista users: please go to User Accounts and Family
Safety > User Accounts > Turn User Account Control on or off, then
uncheck the checkbox of “Use User Account Control (UAC) to help
protect your computer”. Restart your computer to validate the
setting. For additional information of User Account Control, please go
to
http://www.microsoft.com/windows/products/windowsvista/features/details
/useraccountcontrol.mspx

* For Windows 7 users, please go to Control Panel > User Accounts >
Change User Account Control Setting to lower your notify setting. For
additional information of User Account Control, please go to
http://windows.microsoft.com/en-us/windows7/products/features/user-
account-control
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5.1 Installation

1. Insert the Installation CD-ROM into your computer’s CD-ROM
drive to initiate the Auto-Run program.

2. Click the SecurView™ Pro from the Auto-Run menu screen.

@ TRenDneT

IP Setup

SecurView Pro
User's Guide
Product Registration

Exit

SecurView Outdoor PoE
Megapixel Day/Night
Internet Camera
TV-IP322P

© Copyright 2011 TRENDnet. All Rights Reserved

NOTE: To use SecurView™ Pro, you must have Microsoft .NET
Framework 2.0 installed in the computer. The setup wizard will
detect it and, if the program is not installed yet, it will ask you to
install it during the process of installing SecurView™ Pro.

NOTE: Microsoft® Windows® Installer 3.0 or above is a required
component to install SecurView™ Pro. For more information of
the required component during installation, please visit the
Microsoft support Website.
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3. Then SecurView™ Pro Setup Wizard will appear. Click “Install”.

72 Setup - SecurView Pro @_ﬂ

Ready to Install
Setup is now ready to begin installing SecurViews Pro on your computer.

Click Install to continue with the installation.

4. Wait until the program finish the installation. By default, the
destination location is C:\Program Files\TRENDnet\SecurView

Pro.

r
& Setup - SecurView Pro

Installing
Flease wait while Setup installs SecurView Pro on your computer.

Extracting files...
C:\Program Files\TRENDnet\SecurView Pro\Skin\Resolution2\N_Button_r2_c2.jpg

Cancel
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5. Click “Finish” to finish the installation.

= ,

Completing the SecurView Pro '
Setup Wizard

£ Setup - SecurView Pro

Setup has finished installing SecurView Pro on your
computer. The application may be launched by selecting the
installed icons.

Click Finish to exit Setup.

6. Afterinstalling the SecurView™ Pro, the application is
automatically installed to your computer, and creates a folder in

“ Start \Program\TRENDnet\SecurView Pro”.

TRENDnet
IPSetup
SecurView Pro
FE SecurView Pro
[W8l Streaming Server
B2 Uninstall SecurView Pro hd

1 Back

2|

||L .
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5.2 Using SecurView™ Pro

5.2.1 Launch the Program

To start SecurView™ Pro, click Start > All Programs > TRENDnet
>SecurView™ Pro > SecurView™ Pro. You can also start the program by
double-click the SecurView™ Pro icon on your desktop.

-

SecurView Pro

Please enter user name and password

User name: EG{

Password:

SecurView

rright 2010 TRENDnet. Al

On the login window, enter the User name/Password and click OK to
login. The default User name/Password is admin/admin. If you wish to
save the login information, please select Auto Login.
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5.2.2 Main Window and Features

When you start and login to SecurView™ Pro, the Main window will
display as below:

SecurView

(L) @

eMap

Camera List
CH#  Name 6 |

YornoEo ||| Mo ©
o) GRS AP

— @

The Main window provides you with the information on operating the
system, as well as the control panel such as the Quick Launch buttons,
and so on.

NOTE  For best result, it is higher recommended to configure resolution setting
to 1024 x 768 or higher; otherwise, it cannot be displayed on the screen
when launching the program.

0 Live View Window displays the live video of the connected
camera(s).
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9 Quick Launch Buttons are located below the Live View Window,
providing you with the following quick-launch functions:

Function

Button

U

Logout : To log out the SecurView™ Pro program
Close: To close the SecurView™ Pro program

@

Restore Recording Type: Restore all recording type to current
camera’s setting

All Continuous Recording: Continuous recording on all
cameras

Stop All Recording: Stop recording on all cameras

View Setting: To configure eMap settings
eMap View: To view current maps
Camera Status: Display cameras status

Playback: Playback recorded files

Schedule: Display Schedule Configuration window

@ @. @

Event Server: Setup a SMTP server

Address Book: Add/Remove email address for event
notification

Event Trigger: Setup event trigger configuration

S
&

Device Setting : Set up the camera
Recording Setting: Set up the recording path

@&

Account information: Setup administrator password

Version: Display software version
System Setting: Software settings
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9 Camera View Mode buttons in this area allow you to switch the
camera view mode.

Functions

Display the connected camera(s) in a single camera view
mode.

Display the connected camera(s) in a quad view mode.

Display the connected camera(s) in a 3 x 3 grid view mode.

Display the connected camera(s) in a 13-camera view mode
using a split window. The first camera is displayed as the
major view.

Display the connected camera(s) in a 17-camera view mode
using a split window. The first camera is displayed as the
major view.

Display the connected camera(s) in a N x N grid view mode,
supporting up to 36 cameras.

=IEIEIENEE]=IE

Display the live view of the selected camera in full screen
mode. Click ESC on the keyboard to return to Main window.

Bl

Automatically switch the live view of each connected
cameras in single camera view mode by 30 seconds*. Click
once to start and click again to stop.

* The auto-switch time is set as 30 seconds by default, which
can be changed by clicking the @ - System Setting and

then change the value from the pull-down list of the Auto
Switch time interval option.

9 System Information displays the system information, including the
date and time, and the available storage space of the system.

6 Live View Status provides the status of live view mode, including
Camera List and eMap.
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® Camera List displays the status of the connected cameras. If
multiple cameras are connected, you can switch to the live
view of each camera by simply selecting the camera from

the list.

® eMap allows you to select the desired camera to the view
from the map easily. Please note that you have to set up
the eMap for monitoring in advance.

@ Camera Control Buttons provides the control buttons that allow you
to control the selected camera.

Buttons

Functions

@

Talk On/Off. Click to enable/disable the speaker
function of the connected camera. This option is
available only in single camera view mode.

Listen On/Off. Click to enable/disable the microphone
function of the connected camera. This option is
available only in single camera view mode.

=55

For Pan/Tilt cameras, use this control panel to set the
preset positions (up to 8 positions).

Use Navigation buttons to adjust camera position, and
then select the position number (1~8) from the Set
button.

To move to the preset position, simply select the
position number (1~8) from the Go button.

Navigation Buttons (Left/Right/Up/Down/Home). If the
connected camera has pan/tilt functions, the Navigation
buttons allow you to move the camera lens position.
Clicking the Home (center) button will move the camera
lens to the assigned home position.

bl / Bed

The Patrol/Stop buttons are used to enable/disable the
patrol function of the camera. Click Patrol to start
patrolling through the preset positions once. Click Stop
to stop patrolling.
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5.2.3 Manage the Cameras

Before adding the cameras, please setup the recording setting first.
B Configure Recording Settings

1. Click the button and then select Record Setting.

e

Device Setting

2. Default path is C:\, click Browse and select the desire
directory then click Save to complete the configuration.

To change the time interval for recording, select time from
the pull-down menu.
8 Record Setting H.H

Devica > Record Sefting

Basic '

Recording Path: ¢
0 2 Browse

| Record File: 60 | Seconds Frea space : 256 GB
%! Recycle Mode

* Please choosa the recording target foider.

For example: f
If tha Racording Path is D*Widao l
The network camera's recarding fiies will be saved to D Wideo'Video Date!CH1

The network camera's recording files will be saved to D 'Wideo'Video Data\CH32

Save Cancel

NOTE: The system will automatically delete the oldest files (10%) when the size
of recorded files is up to 90% of the storage space.
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Add a Camera

—
1. Click the &) button and select Device Setting to
Device Setting window.
Device Setting
Record Setting
2. Click New.

display the

JEEE

Device > Device Setting
Device List
Camera Title IP address Port CH# Brand Model Record Type
New Modify

Stream

Remove
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Click on Search, all cameras that’s connected to your
network would appear.

Device > New Camera

Setiing

New Cam
Device Search
Model IP address Port  Device Name MAC Address
Camera 1)
IP addregs
Port:

Account:

Password
Stream

Record

[ naa | [ oo

Save Cancel Back to List |

Select the camera you would like to add and then click Add.

.

-

Device Search

Peadd Ro——Davicadhl MAC Add N
I 192.168.10.150 80 TV-P322P 00:FF:FEFFFF09 ‘
192.168.10151 80 TVHP422W 00:FFFF-FFFFEB
192.168.10.152 80 TVHP312W 00:FFFFFFFFA7
192.168.10.153 80 TVHP410W 00:FF-FF-FFEFF:DA

m

[ Add ] lSearchl [ Close ]
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5. The information of the camera will display on the screen.
It will auto detect the IP address/port number and display
the stream type of the camera. Please type in the correct
user name and password, then select Preview to view live

image.
- Device [=x=]
Device > New Camera
Setting | I
. il
New Camera Device Search | Motion detection area Il
Model: TVAP322P  ~
CameraTile:  TVIP322P PreviewWindow
IP address. 192.168.10.150
Port 80
W
Account admin |
Password: ™%
Stream © MPEG4() MJPEG () H.264
Record: @ No ) Yes
[ Preview ] Disconnect
Save Cancel ] [ Back to List

6. To setup recording style, select Yes on Record option.
These four recording types will appear. Select one of the
recording type, configure it then click Save.

Record: No
@ Continuously Add Schedule
©) Motion
Motion by Schedule S
Digital Input
[ Save I l Cancel I i Back to List ]
Continuously:
Record the stream video continuously
Schedule:
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Records stream video by schedule. You can setup the
schedule by click Add Schedule here.

Click on New to create a new schedule and select the time
to record. Click on Save when finish.

& Schedule Configuration

Schedule > Schedule Configuration
Schedule
Schedule List
Schedule Title Sun  Mon  Tue Wed Thu Fri  Sat
New
Weekly Schedule
Schedule Title: Work Time Select All Delete All
01 2 3 4 & 6 7 8 9 10 1112 13 14 1516 17 18 19 20 21 2 23 24
sun TT T T T T T T T T T T T T TTTTTT TTTTT T
won [ TTTITTTTIITTTIITTTITITTTT ITTTT 1
Tue [T T WO T TT T WTTTTTTTIT |_ BN LI
Wed H_ENEEEE BN | L |
Thu IH__EENI || || I1
Fri | TTTTTTTTTITTITTTT TTTTT 1 [
sat EESEEEEEEEEEEEEEEEEE] TTTTT 1
= One checkbox means recording for 30 minutes. ®[Cick! © Slide -
* For example: 00:01 ~ 00:30, 00:31~ 01:00 Sae

Motion:

Record video by Motion Detection. Motion detection
recording required to setup a motion detection area. If you
are adding a new camera, you must preview the camera
first in order to setup the motion detection area.
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Click on Motion detection area to setup

Device > Modify Camera TV-IP322P
Setting

Modify Camera  Device Search \ Motion detection area

)

Model TVAP322P  ~

CameraTie:  TVIP322P Preview Window

IP address: 192.168.10.150
Port 80
"

Account: admin |
Password: ™%
Stream © MPEG4() MJPEG () H.264
Record @ No Yes

Save ‘ Cancel ‘ Back to List

Enable motion detection windows, set up the senstivity and
click on Save.

Hotion Detect

[ZEnabe

Sensitivity
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Motion by Schedule:
same requirement as Motion & Schedule recording.

Digital Input:

Recording triggered when there 1/0O port is triggered.
After all recording methods are configured, click Save to
apply the settings.

——

Device > Modify Camera TV-1P322P

seting |
Modify Camera  Device Search Motion detection area

Model: TVIP322P  ~

Preview Window

Camera Titie TV

IP address: 192
Port 80 SecurViewPro

Account admin

Password

Stream MPEGA ) MUPEG

Record No Yes

Preview Disconnect

Save Cancel Back to List
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Camera list will appear with recording type notification.

)

Device > Device Sefting

Device List
Camera Title P address Pot  CH# Brand Model Record Type Stream
TwP322P 192.168.10.150 80 1 TRENDnet TviP322P Not Recording MPEG4

New | Mudlw] [Remws_

Once you added all the cameras, click the close button “x”
on the Device Setting windows to return to the main
windows. The cameras will display here.

Device > Device Sefting ’

Device List
Camera Tite  IP address Port  CH# Brand Model Record Type Stream
TVAP322P 192.168.10150 80 1 TRENDnet TV4P322P Not Recording MPEG4

TVAP422WN  192.168.10150 80 2 TRENDnet TVAP422WN Not Recording MPEG4
TVIP312WN 19216810152 80| - T
TVIPA10WN 19216810153 80|

B SecurView

3/30/2011
14:32.27

£:320GB
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NOTE  Divx/Xvid codec is required for viewing the image of camera. If the
image cannot be displayed in the Live View/Preview window normally,
click the following path to download and install the required component:
http://download.divx.com/divx/DivXInstaller.exe

B Edit / Delete a Camera

1. To edit a camera: From the Device Setting window,
highlight the camera you would like to edit then click on
Modify button.

s —————

Device > Device Sefting

Device List
Camera Tile 1P address. Pot  CH# Brand Model Record Type Stream |
TVAP322P 192.168.10150 80 1 TRENDnet  TV.P322P NotRecording  MPEG4
TVAP422WN 192168 10.151 80 2 TRENDnet TVIP422WN Not Recording MPEG4
TVIP312WN 19216810152 80 3 TRENDnet TVAP312WN NotRecording  MPEG4
TVAP410WN 19216810153 80 2  TRENDnet TVIP410WN Not Recordina MJPEG

N

New Modity | [Remove-
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2. To delete a camera: select the desired one and then click
Remove. Click Yes to confirm.

e ———————————.

Device > Device Seffing |

Device List

Camera Title  IP address Pot  CH# Brand Model Record Type Stream
TVAP322P 19216810150 80 1 TRENDnet TVIP322P Not Recording MPEG4
[TVP422WN 192168101451 80 2  TRENDnet TVIP422WN Mot Recording

TVIP312WN 192168 10152 80 3 TRENDnet  TVIP312WN Not Recording MPEG4
TVAP410WN 192.168.10153 80 2 TRENDnet  TVAP410WN Not Recordina MJPEG

N

New Modify Remove

B View Camera Image

Since you have added camera(s) to the system, the image of the
selected camera(s) will be displayed on the Live View Window
automatically. You can view a maximum of 36 cameras
simultaneously. Additionally, you can select one-camera or
other view mode to display the video from the Camera View
Mode buttons.

For example, if you use only one camera, select single camera

view mode ( D ), and the Live View Window will display the
view as below. You can select the other modes according to
your need.

-92 -



The Information icon ( n ) on the top-right corner of the
window provides you with the options to connect/disconnect
the camera, select a camera to be displayed in the window,
capture a still image of the camera live video, or switch to eMap
mode. Click the Information icon to pop up the shortcut menu

and select the desired option.
Connect

Disconnect

Show Camera 3
Snapshot

eMap

Secu

/30120
14:37:58
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B Playback the Recorded Files

1. Click the G button to display the Playback window.

2. On the Playback window, select the camera and setup the
begin/end date and begin/end time, then click Search. The
search result will be displayed in the Record File list.

9 Playback ==
1
Playback
mdi * Please download the MPEG4 codec, i it is not yet insialod on your system. miged codes
Single Ghannel
I
Search
Camera Begin Date: 3302011 (- BeginTme: q3g1gpM |2
1:TVAP322P(192.168 10.150) xm aao2om G- EdTme  25018PM 3
Search
Record File Playback

G ivideo Data'CH1R011330CH1_2011 03 -
je0 Data'CH1201

jeo Data'CH1201 HI_2011.03
1Video DatalCH1Z011\3B0CHT_2011 03

000000

Play ‘ Stop | | Dewnioad

J

-94 -



3. To playback the video clip, select the desired file and click
Play.

& Playback - J——
| Playback
e * Please download the MPEGA codec, if it is not yet instaled on your system. nioad codec
Single Channel

\ |

|
Search
Camera Begin Date: 3302011 (3~ BeginTme: 13018 PM

1TVIP322P(192.168.10.150) »| End Date: 330/2011 [~ EndTime: 25018 PM

Search

Record File Playback
C \\Video Data\CH1'20111330\CH1_2011.03

C 2

C\\Video Datal( \330\CH1 2011.03
C{iVideo Data\CH1'20111330ICH1_2011.03
C:\\ideo Data\CH1'2011\3130\CH1_2011 03

Play Stop Download

5.2.4 eMap Setup & Camera Status

B Manage eMap

Click the ;,, button and select View Setting to manage eMap.

View Setting

eMap View

| Camera Status

eMap refers to the geography and device scope in the
SecurView™ Pro, which visually presents the devices in your
security system. It uses a background of the area (e.g. a picture
or a map) as the interface for monitoring.
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To add an eMap

1. Onthe View Setting window, click New.
View > View Setting I
eMap
oMap List
eMap Name Image w
|
Remove

Browse

Save Cancel

2. Enter an eMap name.

e S —————————————
View > View Setling
eMap

aMap List

eMap Name Image

'

Modify

i

shiap Name: I Preview
Home]

Image File.

[sae]

Cancel |
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Click Browse to select a Picture File from your computer
Picture will display in the Preview window.
View Setti

View > View Sefting

eMap

eMap List

| eMap Name image

[ New |
[odity ]
[Remove |
eMap Information
eMap Name.
Home
Image File:

C\OutdoorMap jpg

S

"Cancel |

Click Save and click OK to apply the settings
CALTE

View > View Satling

X3
"eMap

eMap List

eMap Name

Image
Home

1
C\OutdoorMap jpg

eMap Information

'
f
eMap Name.
Home
Image File

C:\OutdoorMap jpg

Save
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Click Camera Location to assign the camera location.
S —— S

View > View Setting

eMap
aMap List
eMap Name Image
Home C\OutdoorMap jpg New

eMap Information

eMap Name:

Home:

Image File

C\0utdoorMap jpg

Save !amem Location

The following screen appears.

£ait the 's positon -

Camera List MAP Name: l

[01TVIP322P
02TVIP422WN
103 TVIP312WN
04 TVIP410WN

* Select a camera from the camera list and then click on the desired camera position on the map to place the cal
* Click on the camera icon on the map to remove it from the map

[Csae ] [[Baex |

-08 -



Select the camera from the list and then click the position

on the map. The camera icon &will be displayed on map.

o Edit the M: ¥ e - -

Camera List: MAP Name:

03TVIP312WN
04.TV-IP410WN

* Select a camera from the camera list and then click on the desired camera position on the map to place the cﬁ
* Click on the camera icon on the map to remove it from the map.

| S ] [ ]

Click Save when complete.

S it e Map and Caera's positon ®

Camera List MAP Name: i

03 TVAP312WN
04 TVAP410WN

* Select a camera from the camera list and then click on the desired camera position on the map to place the caf
* Click on the camera icon on the map to remove it from the map.

Save | Back |
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To modify/remove an eMa
1.

To edit the eMap: In the eMap List, select the map name from eMap
list, and click Modify.

View > View Sefting
eMap
eMap List
elMap Name Image
Home: C:\0utdoorMap jpg [ Hew
| Modify
Remove
eMap Information
ehlap Name Preview
Home ol
Image File: i )
™
C-\OutdoorMap jpg Browse — -
Save Cancel Camera Location

2.

The map’s information will display on the preview windows. After
changes the setting information, click Save to save the setting.
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Vi

View > View Setting

éMap |
eMap List
eMap Name Image B —
Home C:\OutdoorMap jpg New
Modify
Remove |
SecurViewPro
eMap Information
eMap information saved.
eMap Name:
Home
Image File:
C\OutdoorMap jpg
sow Gamera Location |

To delete the eMap: In the eMap List, select the desired one and
click Remove. The selected map will be removed from the list.

o View Settiny
View > View Setting
eMap
| y
eMap List
| eMap Name image o)
low
Modify
Ramuvs}
Browse
I
I Save Cancel
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B View eMap

a. Clickthe @ button and select eMap View.

jew Setting

Camera Status

b. Select the map from the eMap Name list.
r v

[ SecurView
PRO

elap List
ehMap Name A\

oMap
Camera List

Che#  Name
o1 TIP3
02 TVP4
0 TP
04 TVP4 I

| cosenap |
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B Camera Status Click the camera icon &, the camera Live
Monitor window will display live image on that camera.

3/30/2011
17:21:02

C: 320GB

5.2.5 System Info

B Account

Click the @ System button and select Account to change the
administrator password of the system.

Version
System Setting
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Enter the Current password, and then enter the new password
twice (in the Type new password and Retype password boxes).
Then click Save.

R — —— X

System > Account Setting

Administrator

Current password.

Type new password

Retype password

Save Cancel

B Version

Click the @ System button and select Version to view the
current firmware version of the system.

i’ Systemversi

System > Version

SecurView Pro

Version: KEXX

Last Update:  XX/XX/XXXX

Warning: This computer program is protected by copyright law and
intemational treaties. Unauthorized reproduction or distribution of this
program, or any portion of it, or the use with a registration key without the
explicit permission may result in severe criminal and civil penalties, and will
be prosecuted to the maximum extent possible under law.
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B System Setting

Click the @ System button and select System Setting. Auto
Scan period can be set from 30 seconds to 100 seconds.

— - . | M

System > System Setting

Auto Scan time interval Seconds

[] Start the software when windows start

[] Auto login

5.2.6 Event Settings

u Setting up Event Server

Click the @ button and select Event Server to configure the
SMTP settings for email notification use.

Address Book

Event Trigger
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e o ——— i

Event > Event Server

SMTP

Enable SMTP
I SMTP Server Addr mailserver.com
Sender Email Addr john@mailserver.com
Authentication Mod”) None @ SMTP

Sender User Namejohn

Sender Password: sy

Port Number: 25

] sSL

[ Save ] [Cance\ ] [Remuve]

Select the Enable SMTP option and configure the following
information correctly to start the email feature.

® SMTP Server Address: Enter the mail server address.
For example, mymail.com or smtp.gmail.com or
smtp.live.com

® Sender Email Address: Enter the email address of the user
who will send the email. For example,
John@mailserver.com.

® Authentication Mode: Select None or SMTP according to
the mail server configuration.

® Sender User Name: Enter the user name to login the mail
server.

® Sender Password: Enter the password to login the mail
server.
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® Port Number: Enter the port number used for the email
server.

® SSL: If the mail server requires an encrypted connection,
you should check the SSL option. For example, gmail users,
please select this option.

When completed, click Save and then select OK. The system will
automatically start the Event Service.

TIP The status of Event Service is indicated by the [ icon in the system
bar.
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B Sending Notification to the User

Click the @ button and select Address Book to assign the user
to the Address Book of the camera. The user will receive a real-
time notification from the system while triggering out.

Event Server

Address Book

Event Trigger

55 Address Book ==
| Event > Address Book
Address Book List
List Name Email
John john@maitserver com
I New |
Modify |
[Remove | |
i
i
]
Address Book Information
Name: Mary
Email. mary@hotmail.com
| saw [ cancel
"
= |

1. Onthe Address Book window, click New.

2. Inthe Address Book Information field, enter the Name and
Email of the user.

3. When completed, click Save. The user will be displayed in
the Address Book List.

4. To edit the user: In the Address Book List, select the
desired user and click Modify. The user’s information will
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be displayed, where you can change the user’s information
and then click Save when completed.

5. To delete the user: In the Address Book List, select the
desired user and click Remove. The selected user will be
removed from the list.

B Configuring Event Trigger

Click the @ button and select Event Trigger to configure the
trigger out function of the camera.

Event Server
Address Book

Event Trigger

2 verc T =)
Event > Event Trigger
Gemera List Trigger Sefting
C. Mame  IPaddress Port Add Address Book
1 TIP3 1921681 80 SMTP  Address Book List
2 TVIPA. 1021681 80 Name Email
3 TVIP3. 1921681. 80
4 TVIPA. 1921681. B8O
Subject
|
Massage
]
|
Play Sound Browse || Test
eMap Popur| =
Save | Cancel |

1. Onthe Event Trigger window, select the desired camera
from the Camera List.
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2. Do one of the following:

® SMTP: Select this option and enter the Subject and
Message, the system will send an email message to the
selected user(s) in the Address Book List.

® Play Sound: Select this option select a sound file from
the computer, so that the system will alarm by the
sound while triggering out.

® eMap Popup: Select this option and select the eMap
profile from the pull-down menu. The camera view of
the eMap will be displayed while triggering out.

5.2.7 Close Program

When you have finished operating, click the U button and select
Logout to logout the system or Close to exit the program.

Logout
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CHAPTER 6

How to access the camera behind a Router

You can either setup the Dynamic DNS connection via camera itself or
your home router. An account from any of the listed DDNS providers is
required prior to this operation.

Configure DDNS on your Camera

1. Goto Camera’s DDNS Setting page, click Enable to activate the
feature. Then select a DDNS provider from the list.

DDNS Setting: Enable
Provider: wiw_dyndns.com ~|
d
Host Name: members easydns.com
. web_easydns.com
User Name:

www.EuroDynDNS.org
Www.no-ip.com

www ovh.com

www regfish.com

Password:

2. Enter your DDNS'’s the Host Name, User Name and Password.

DDNS Setting: Enable
Provider: www.dyndns.com -
Host Name trendnet.dyndns.org
User Name: trendnet
Password: ssssssssssseses
UPnP: Enable
Ports Number:
HTTP Port: 9000 (default: 80}
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In the Port Number section, assign an HTTP port of the camera.
The default HTTP Port on the camera is 80. The example shows
above is using port number 9000.

Open another web browser and go to your Router’s Web
Configuration page. (In the example, TRENDnet’s TEW-651BR
Wireless N router is used)

@ TRENDNET

Main
Wireless
Status

Routing
Access

+ Filter

~ Virtusl server
~ Special AP

+ DMZ

~ Firewall Rule
Management
Tools

Wizard

Virtual Server

150Mbps Wireless N Home Router

Enable| " Enable @ Disabled

TEW-651BR

Help

Name

Protocol

Private Port

Public Port

LAN Server

|

Name

Protocol

Virtual Server FTP

TCP 21121

Virtual Server HTTP

TCP 80780

Virtual Server HTTPS

TCP 443/443

Virtual Server DNS

UDP 53/53

Virtual Server SMTP

TCP 25/25

Virtual Server POP3

TCP 1101110

Virtual Server Telnet

TCP 23123

PPTP

TCP 172311723

Netileeting

TCP 172011720

Copyright © 2008 TRENDnet. All Rights Reserved.

Go to Virtual Server* section and create a new entry.
Enable: Click Enable
Name: Enter the application name (eg. CameraName)
Protocol: Select TCP
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Private Port: The HTTP port that you assign on your Camera.
Public Port: The port used on remote side to access to your
Camera.

LAN Server: The local IP address of your Camera.

Virtual Server

Enable| '@ Enable Disabled

Name | IP Camera

Protocol| TCP ~

Private Port | 9000

Public Port | 9000

LAN Server| 192.168.1.101

Then click Add to add the application.

* Please refer to your router’s user’s manual for detail Virtual
Server setting. Some router might use Port Forwarding or
Special applications for this function. The setup steps should
be very similar.

Name Protocol LAN Server

Virtual Server FTP TCP 21/21 0000

Virtual Server HTTP TCP 80/80 0000

Virtual Server HTTPS TCP 443/443 0.0.00

Virtual Server DNS UDP 53/53 0000

Virtual Server SMTP TCP 2525 0000

Virtual Server POP3 TCP 110/110 0.0.00

Virtual Server Telnet TCP 23123 00.00

PPTP TCP 172311723 0.0.00

NetMeeting TCP 172011720 0.0.00

IP Camera TCP 9000/9000 192.168.1.101

Copyright © 2009 TRENDnet. All Rights Reserved.
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6.

7.

Open another web browser and enter your DDNS domain and

camera’s port number.

http://yourDomainName:PortNumber

€ New Tab - Windows Internet Explorer

e http://trendnet.dyndns.org:9000|

Camera’s login page will appear.

Configure DDNS on your router

1.

Go to Camera’s DDNS - Ports Number section, assign a HTTP

port for your camera and click Apply.

DDNS Setting: [F] Enable
Provider: www.dyndns.com -
Host Name:
User Name:
Password:
UPnP: [C] Enable
Ports Number: HTTP Port: 90000 (default: 80)

Login to your router’s web configuration page.
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3. Find the Dynamic DNS configuration section.

@ TREnDnET 150Mbps Wireless N Home Router

TEW-651BR

B I
Dynamic DNS T nep

« LAN & DHCP Server

- WAN - -
DDNS Enabled @ Disabled
« Password

- Time Server Address | | DynDns com

+ Dynamic DNS
Host Hame

Wireless
User Name

Status
Password

Routing

Access

_—.Vr
Management

Copyright © 2003 TRENDnet. All ights Reserved.

4. Enable DDNS, fill out the following information and then click
Apply.

Dynamic DNS

DDNS | @ Enabled () Disabled

Server Address | DynDns.com ~

Host Name | trendnet.dyndns.org

User Name | trendnet

| o |

P d
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5.

7.

Go to Virtual Server* section and create a new entry.
Enable: Click Enable

Name: Enter the application name (eg. Camera Name)
Protocol: Select TCP

Private Port: The HTTP port that you assign on your Camera.
Public Port: The port used on remote side to access to your
Camera.

LAN Server: The local IP address of your Camera.

Virtual Server Help

Enable| ‘@ Enable () Disabled

Name| IP Camera

Protocol| TCP ~

Private Port | 9000

Public Port | 2000

LAN Server| 192.168.1.101
e
Click Add to add the application.

* Please refer to your router’s user’s manual for detail Virtual
Server setting. Some router might use Port Forwarding or
Special applications for this function. The setup steps should
be very similar.

Open another web browser and enter your DDNS domain and
camera’s port number.
http://yourDomainName:PortNumber

€ New Tab - Windows Internet Explorer

e

@ http://trendnet.dyndns.org:9000]

The camera login page will appear.
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Appendix

A.1 Specification

Image Sensor
Sensor
Resolution

Min. lllumination

System Hardware
Processor

RAM

ROM

Power

Lens Assembly
Lens Type

Lens Specification
View Angle

Night Vision

Video
Compression
Video Resolution

1/3” 2-megapixel color CMOS Sensor
1600 x 1200
0 Lux

ARMS9 base
64MB SDRAM
8MB NOR Flash
DC12Vv / AC24V

Board lens
F1.8, 12mm
28.5 degree

850nm IR LED (Auto mode and Schedule
mode supported); up to 20M

H.264/MPEG4/MIPEG

SXGA (1280 x 1024) @ 15fps;
VGA (640 x 480) @ 30 fps;
QVGA (320 x 240) @ 30 fps;
QQVGA (160 x 120) @ 30 fps
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Audio
Input
Output
Format

User Interface
LAN

SD Card Slot
1/0 Connectors

Communication
LAN

PoE
Protocol Support

Software
OS Support
Browser
Software

Operating Environment

Temperature

Humidity

EMI

3.5mm external microphone input jack
3.5mm speaker output jack (Mono)
PCM/AMR (AMR is for 3GPP only)

RJ-45 port
Yes
GPIO: 2-in/1-out connectors; RS-485; AC24V

10/100Mbps Fast Ethernet, auto-sensed,
Auto-MDIX

IEEE802.3af

TCP/IP, IPv4, IPv6, UDP, ICMP, DHCP, NTP,
DNS, DDNS, SMTP, FTP, HTTP, HTTPs, Samba,
PPPoE, UPnP, Bonjour, RTP, RTSP, RTCP

Windows™ 2000/XP/Vista
Internet Explorer 6.0 or above

SecurView™ Pro for playback/motion
detection/recording configuration features

Operation: -20°C ~ 60°C;

Storage: -20°C ~ 65°C

Operation: 20% ~ 85% non-condensing;
Storage: 0% ~ 90% non-condensing

FCC/CE
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A.2 GPIO Terminal Application

Typically used in association with programming scripts for developing
applications for motion detection, event triggering, alarm notification via
e-mail, and a variety of external control functions. The 8-pin |I/O Terminal
Block is located on the rear panel and provides the interface to: a photo-
coupled switch output, a photo-coupled input, and RS-485 interface. The
RS-485 is typically used for pan/tilt control.

Connector Pin Assignment

PIN FUNCTION

SPECIFICATION

1 Ground (common)

GND

(Normal Open)

2 IN1 Active High voltage 9~40VDC
Photo-Relay INPUT (+)
3 IN2 Dropout voltage 0 VDC.
Close circuit current maximum
70mA AC or 100mA DC.
4 OUT+ Photo-Relay OUTPUT Output resistance 30 Ohm.

Open circuit voltage maximum
240V AC or 350V DC.

5 Ground (common)

GND

6 DC12v DC +12V output

Power distribution: 250mA max.

7 TX+ RS-485 (+) or (A)

8 TX- RS-485 (-) or (B)

Compliant to RS-485.

AC24V Power Input

AC Power
AC24V Power Input
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A.3 Bandwidth Reference Guide

H.264
Frame Bit rate (Kbit/s)
Resolution
rate (fps) | Lowest | Low | Normal | High Highest
QQVGA 30 128 128 128 128 128
QVGA 30 128 128 256 512 1024
VGA 30 128 128 512 1024 2048
SXGA 15 192 192 768 1536 3072
MPEG4
Frame Bit rate (Kbit/s)
Resolution
rate (fps) Lowest Low Normal High Highest
QQVGA 30 128 128 128 128 128
QVGA 30 128 128 256 512 1024
VGA 30 128 256 512 1024 2048
MIJPEG
Image size (KB)
Resolution
Lowest Low Normal High highest
QQVGA 1.5 1.9 2.4 2.7 4.1
QVGA 3.2 4.2 5.4 6.3 9.7
VGA 8.8 11.2 14 16 24.3
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A.4 Glossary of Terms

NUMBERS
10BASE-T

100BASE-TX

ADPCM

AMR

Applet

ASCII

ARP

AVI

BOOTP

(g}

10BASE-T is Ethernet over UTP Category Ill, IV, or V
unshielded twisted-pair media.

The two-pair twisted-media implementation of 100BASE-T is
called 100BASE-TX.

Adaptive Differential Pulse Code Modulation, a new
technology improved from PCM, which encodes analog
sounds to digital form.

AMR (Adaptive Multi-Rate) is an audio data compression
scheme optimized for speech coding, which is adopted as
the standard speech codec by 3GPP.

Applets are small Java programs that can be embedded in an
HTML page. The rule at the moment is that an applet can
only make an Internet connection to the computer form
that the applet was sent.

American Standard Code For Information Interchange, it is
the standard method for encoding characters as 8-bit
sequences of binary numbers, allowing a maximum of 256
characters.

Address Resolution Protocol. ARP is a protocol that resides
at the TCP/IP Internet layer that delivers data on the same
network by translating an IP address to a physical address.

Audio Video Interleave, it is a Windows platform audio and

video file type, a common format for small movies and
videos.

Bootstrap Protocol is an Internet protocol that can
automatically configure a network device in a diskless
workstation to give its own IP address.
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Communication

Connection

DHCP

DNS

E

Communication has four components: sender, receiver,
message, and medium. In networks, devices and application
tasks and processes communicate messages to each other
over media. They represent the sender and receivers. The
data they send is the message. The cabling or transmission
method they use is the medium.

In networking, two devices establish a connection to
communicate with each other.

Developed by Microsoft, DHCP (Dynamic Host Configuration
Protocol) is a protocol for assigning dynamic IP addresses to
devices on a network. With dynamic addressing, a device
can have a different IP address every time it connects to the
network. In some systems, the device's IP address can even
change while it is still connected. It also supports a mix of
static and dynamic IP addresses. This simplifies the task for
network administrators because the software keeps track of
IP addresses rather than requiring an administrator to
manage the task. A new computer can be added to a
network without the hassle of manually assigning it a unique
IP address. DHCP allows the specification for the service
provided by a router, gateway, or other network device that
automatically assigns an IP address to any device that
requests one.

Domain Name System is an Internet service that translates
domain names into IP addresses. Since domain names are
alphabetic, they're easier to remember. The Internet
however, is really based on IP addresses every time you use
a domain name the DNS will translate the name into the
corresponding IP address. For example, the domain name
www.network_camera.com might translate to
192.167.222.8.

Enterprise network An enterprise network consists of collections of networks

connected to each other over a geographically dispersed
area. The enterprise network serves the needs of a widely
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Ethernet

F

Fast Ethernet

Firewall

G

Gateway

Group

= o

HEX

distributed company and operates the company’s mission-
critical applications.

The most popular LAN communication technology. There
are a variety of types of Ethernet, including 10Mbps
(traditional Ethernet), 100Mbps (Fast Ethernet), and
1,000Mbps (Gigabit Ethernet). Most Ethernet networks use
Category 5 cabling to carry information, in the form of
electrical signals, between devices. Ethernet is an
implementation of CSMA/CD that operates in a bus or star
topology.

Fast Ethernet, also called 100BASE-T, operates at 10 or
100Mbps per second over UTP, STP, or fiber-optic media.

Firewall is considered the first line of defense in protecting
private information. For better security, data can be
encrypted. A system designed to prevent unauthorized
access to or from a private network. Firewalls are frequently
used to prevent unauthorized Internet users from accessing
private networks connected to the Internet, especially
Intranets all messages entering or leaving the intranet pass
through the firewall, which examines each message and
blocks those that do not meet the specified security criteria.

A gateway links computers that use different data formats
together.

Groups consist of several user machines that have similar
characteristics such as being in the same department.

Short for hexadecimal refers to the base-16 number system,
which consists of 16 unique symbols: the numbers 0 to 9
and the letters A to F. For example, the decimal number 15
is represented as F in the hexadecimal numbering system.
The hexadecimal system is useful because it can represent
every byte (8 bits) as two consecutive hexadecimal digits. It

-123 -



Intranet

Internet

Internet address

IP address

ISP

is easier for humans to read hexadecimal numbers than
binary numbers.

This is a private network, inside an organization or company
that uses the same software you will find on the public
Internet. The only difference is that an Intranet is used for
internal usage only.

The Internet is a globally linked system of computers that
are logically connected based on the Internet Protocol (IP).
The Internet provides different ways to access private and
public information worldwide.

To participate in Internet communications and on Internet
Protocol-based networks, a node must have an Internet
address that identifies it to the other nodes. All Internet
addresses are IP addresses

Internet Protocol is the standard that describes the layout of
the basic unit of information on the Internet (the packet)
and also details the numerical addressing format used to
route the information. Your Internet service provider
controls the IP address of any device it connects to the
Internet. The IP addresses in your network must conform to
IP addressing rules. In smaller LANs, most people will allow
the DHCP function of a router or gateway to assign the IP
addresses on internal networks.

IP address is a 32-binary digit number that identifies each
sender or receiver of information that is sent in packets
across the Internet. For example 80.80.80.69 is an IP
address. When you “call” that number, using any connection
methods, you get connected to the computer that “owns”
that IP address.

ISP (Internet Service Provider) is a company that maintains a
network that is linked to the Internet by way of a dedicated
communication line. An ISP offers the use of its dedicated
communication lines to companies or individuals who can’t
afford the high monthly cost for a direct connection.
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Java is a programming language that is specially designed for
writing programs that can be safely downloaded to your
computer through the Internet without the fear of viruses. It
is an object-oriented multi-thread programming best for
creating applets and applications for the Internet, Intranet
and other complex, distributed network.

Local Area Network a computer network that spans a
relatively small area sharing common resources. Most LANs
are confined to a single building or group of buildings.

MIJPEG (Motion JPEG) composes a moving image by storing
each frame of a moving picture sequence in JPEG
compression, and then decompressing and displaying each
frame at rapid speed to show the moving picture.

MPEG4 is designed to enable transmission and reception of
high-quality audio and video over the Internet and next-
generation mobile telephones.

Network Address Translator generally applied by a router
that makes many different IP addresses on an internal
network appear to the Internet as a single address. For
routing messages properly within your network, each device
requires a unique IP address. But the addresses may not be
valid outside your network. NAT solves the problem. When
devices within your network request information from the
Internet, the requests are forwarded to the Internet under
the router's IP address. NAT distributes the responses to the
proper IP addresses within your network.

A network consists of a collection of two or more devices,
people, or components that communicate with each other
over physical or virtual media. The most common types of
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network are:

LAN — (local area network): Computers are in close distance
to one another. They are usually in the same office space,
room, or building.

WAN - (wide area network): The computers are in different
geographic locations and are connected by telephone lines
or radio waves.

A network protocol that can automatically negotiate the
highest possible transmission speed between two devices.

PCM (Pulse Code Modulation) is a technique for converting
analog audio signals into digital form for transmission.

Packet Internet Groper, a utility used to determine whether
a specific IP address is accessible. It functions by sending a
packet to the specified address and waits for a reply. It is
primarily used to troubleshoot Internet connections.

Point-to-Point Protocol over Ethernet. PPPoE is a
specification for connecting the users on an Ethernet to the
Internet through a common broadband medium, such as
DSL or cable modem. All the users over the Ethernet share a
common connection.

Communication on the network is governed by sets of rules
called protocols. Protocols provide the guidelines devices
use to communicate with each other, and thus they have
different functions. Some protocols are responsible for
formatting and presenting and presenting data that will be
transferred from file server memory to the file server’s net
work adapter Others are responsible for filtering
information between networks and forwarding data to its
destination. Still other protocols dictate how data is
transferred across the medium, and how servers respond to
workstation requests and vice versa. Common network
protocols responsible for the presentation and formatting of
data for a network operating system are the Internetwork
Packet Exchange (IPX) protocol or the Internet Protocol (IP).
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Protocols that dictate the format of data for transferors the
medium include token-passing and Carrier Sense Multiple
Access with Collision Detection (CSMA/CD), implemented as
token-ring, ARCNET, FDDI, or Ethernet. The Router
Information Protocol (RIP),a part of the Transmission
Control Protocol/Internet Protocol (TCP/IP) suite, forwards
packets from one network to another using the same
network protocol.

RJ-45 connector is used for Ethernet cable connections.

A router is the network software or hardware entity charged
with routing packets between networks.

RTP (Real-time Transport Protocol) is a data transfer
protocol defined to deliver live media to the clients at the
same time, which defines the transmission of video and
audio files in real time for Internet applications.

RTSP (Real-time Streaming Protocol) is the standard used to
transmit stored media to the client(s) at the same time,
which provides client controls for random access to the
content stream.

It is a simple computer that provides resources, such as files
or other information.

SIP (Session Initiated Protocol) is a standard protocol that
delivers the real-time communication for Voice over IP
(VolIP), which establishes sessions for features such as audio
and video conferencing.

The Simple Mail Transfer Protocol is used for Internet mail.

Simple Network Management Protocol. SNMP was designed
to provide a common foundation for managing network
devices.

In LANSs, a station consists of a device that can communicate
data on the network. In FDDI, a station includes both
physical nodes and addressable logical devices.
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Workstations, single-attach stations, dual-attach stations,
and concentrators are FDDI stations.

In TCP/IP, the bits used to create the subnet are called the
subnet mask.

Transmission Control Protocol/Internet Protocol is a widely
used transport protocol that connects diverse computers of
various transmission methods. It was developed y the
Department of Defense to connect different computer types
and led to the development of the Internet.

A transceiver joins two network segments together.
Transceivers can also be used to join a segment that uses
one medium to a segment that uses a different medium. On
a 10BASE-5 network, the transceiver connects the network
adapter or other network device to the medium.
Transceivers also can be used on 10BASE-2 or 10BASE-T
networks to attach devices with AUl ports.

The User Datagram Protocol is a connectionless protocol
that resides above IP in the TCP/IP suite

The USERNAME is the unique name assigned to each person
who has access to the LAN.
It is a program that performs a specific task.

Unshielded twisted-pair. UTP is a form of cable used by all
access methods. It consists of several pairs of wires enclosed
in an unshielded sheath.

Wide-Area Network. A wide-area network consists of groups
of interconnected computers that are separated by a wide
distance and communicate with each other via common
carrier telecommunication techniques.
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WEP

Windows

WPA

WPA2

WEP is widely used as the basic security protocol in Wi-Fi
networks, which secures data transmissions using 64-bit or
128-bit encryption.

Windows is a graphical user interface for workstations that
use DOS.

WPA (Wi-Fi Protected Access) is used to improve the
security of Wi-Fi networks, replacing the current WEP
standard. It uses its own encryption, Temporal Key Integrity
Protocol (TKIP), to secure data during transmission.

Wi-Fi Protected Access 2, the latest security specification
that provides greater data protection and network access
control for Wi-Fi networks. WPA2 uses the government-
grade AES encryption algorithm and IEEE 802.1X-based
authentication, which are required to secure large corporate
networks.
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Limited Warranty

TRENDnet warrants its products against defects in material and
workmanship, under normal use and service, for the following lengths of
time from the date of purchase.

TV-IP322P - 3 Years Limited Warranty

AC/DC Power Adapter, Cooling Fan, and Power Supply carry 1 year
warranty.

If a product does not operate as warranted during the applicable
warranty period, TRENDnet shall reserve the right, at its expense, to
repair or replace the defective product or part and deliver an equivalent
product or part to the customer. The repair/replacement unit’s warranty
continues from the original date of purchase. All products that are
replaced become the property of TRENDnet. Replacement products may
be new or reconditioned. TRENDnet does not issue refunds or credit.
Please contact the point-of-purchase for their return policies.

TRENDnet shall not be responsible for any software, firmware,
information, or memory data of customer contained in, stored on, or
integrated with any products returned to TRENDnet pursuant to any
warranty.

There are no user serviceable parts inside the product. Do not remove
or attempt to service the product by any unauthorized service center.
This warranty is voided if (i) the product has been modified or repaired
by any unauthorized service center, (ii) the product was subject to
accident, abuse, or improper use (iii) the product was subject to
conditions more severe than those specified in the manual.

Warranty service may be obtained by contacting TRENDnet within the
applicable warranty period and providing a copy of the dated proof of
the purchase. Upon proper submission of required documentation a
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Return Material Authorization (RMA) number will be issued. An RMA
number is required in order to initiate warranty service support for all
TRENDnet products. Products that are sent to TRENDnet for RMA service
must have the RMA number marked on the outside of return packages
and sent to TRENDnet prepaid, insured and packaged appropriately for
safe shipment. Customers shipping from outside of the USA and Canada
are responsible for return shipping fees. Customers shipping from
outside of the USA are responsible for custom charges, including but not
limited to, duty, tax, and other fees.

WARRANTIES EXCLUSIVE: IF THE TRENDNET PRODUCT DOES NOT
OPERATE AS WARRANTED ABOVE, THE CUSTOMER'’S SOLE REMEDY
SHALL BE, AT TRENDNET’S OPTION, REPAIR OR REPLACE. THE
FOREGOING WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN
LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, EITHER IN
FACT OR BY OPERATION OF LAW, STATUTORY OR OTHERWISE,
INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. TRENDNET NEITHER ASSUMES NOR AUTHORIZES
ANY OTHER PERSON TO ASSUME FOR IT ANY OTHER LIABILITY IN
CONNECTION WITH THE SALE, INSTALLATION MAINTENANCE OR USE OF
TRENDNET’S PRODUCTS.

TRENDNET SHALL NOT BE LIABLE UNDER THIS WARRANTY IF ITS TESTING
AND EXAMINATION DISCLOSE THAT THE ALLEGED DEFECT IN THE
PRODUCT DOES NOT EXIST OR WAS CAUSED BY CUSTOMER'’S OR ANY
THIRD PERSON’S MISUSE, NEGLECT, IMPROPER INSTALLATION OR
TESTING, UNAUTHORIZED ATTEMPTS TO REPAIR OR MODIFY, OR ANY
OTHER CAUSE BEYOND THE RANGE OF THE INTENDED USE, OR BY
ACCIDENT, FIRE, LIGHTNING, OR OTHER HAZARD.

LIMITATION OF LIABILITY: TO THE FULL EXTENT ALLOWED BY LAW
TRENDNET ALSO EXCLUDES FOR ITSELF AND ITS SUPPLIERS ANY
LIABILITY, WHETHER BASED IN CONTRACT OR TORT (INCLUDING
NEGLIGENCE), FOR INCIDENTAL, CONSEQUENTIAL, INDIRECT, SPECIAL,
OR PUNITIVE DAMAGES OF ANY KIND, OR FOR LOSS OF REVENUE OR
PROFITS, LOSS OF BUSINESS, LOSS OF INFORMATION OR DATE, OR
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OTHER FINANCIAL LOSS ARISING OUT OF OR IN CONNECTION WITH THE
SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE, FAILURE, OR
INTERRUPTION OF THE POSSIBILITY OF SUCH DAMAGES, AND LIMITS ITS
LIABILITY TO REPAIR, REPLACEMENT, OR REFUND OF THE PURCHASE
PRICE PAID, AT TRENDNET’S OPTION. THIS DISCLAIMER OF LIABILITY FOR
DAMAGES WILL NOT BE AFFECTED IF ANY REMEDY PROVIDED HEREIN
SHALL FAIL OF ITS ESSENTIAL PURPOSE.

Governing Law: This Limited Warranty shall be governed by the laws of
the state of California.

Some TRENDnet products include software code written by third party
developers. These codes are subject to the GNU General Public License
("GPL") or GNU Lesser General Public License ("LGPL").

Go to http://www.trendnet.com/gpl or http://www.trendnet.com
Download section and look for the desired TRENDnet product to access
to the GPL Code or LGPL Code. These codes are distributed WITHOUT
WARRANTY and are subject to the copyrights of the developers.
TRENDnet does not provide technical support for these codes. Please go
to http://www.gnu.org/licenses/gpl.txt or
http://www.gnu.org/licenses/Igpl.txt for specific terms of each license.
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